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Notice and Disclaimer

This manual’s sole purpose is to assist installers and/or users in the safe and efficient installation and
usage of the system and/or product, and/or software described herein.

& Before attempting to install and/or use the system, the installer and the user must read this
manual and become familiar with all safety requirements and operating procedures.

* The system must not be used for purposes other than those for which it was designed.

* The use of the software associated with the system and/or product, if applicable, is subject to the terms
of the license provided as part of the purchase documents.

® This manual describes the maximum configuration of the system with the maximum number of
functions, including future options. Therefore, not all functions described in this manual may be
available in the specific system and/or product configuration you purchased.

* Incorrect operation or installation, or failure of the user to effectively maintain the system, relieves the
manufacturer (and seller) from all or any responsibility for consequent noncompliance, damage, or
injury.

* The text, images and graphics contained in the manual are for the purpose of illustration and reference
only.

* All data contained herein subject to change without prior notice.

* Inno event shall manufacturer be liable for any special, direct, indirect, incidental, consequential,
exemplary or punitive damages (including, without limitation, any and all damages from business
interruption, loss of profits or revenue, cost of capital or loss of use of any property or capital or injury).

* All graphics in this manual are for reference only, some deviation between the image(s) and the actual
product may occur.

* All wiring diagrams are intended for reference only, the photograph of the PCB(s) are intended for
clearer illustration and understanding of the product and may differ from the actual PCB(s).

AxTraxNG™ V27.7.x.x User Guide 7
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1. Introduction

1. Introduction

( N

= In this manual, unless otherwise stated:

* “AC-225" refers to both the regular AC-225 and the AC-225IP models
* “AC-425" refers to both the regular AC-425 and the AC-425IP models.
* All panel and expansion references apply to both the ‘A’ and ‘B’ versions of that panel.

* ‘A’ panels work with the ‘A’ versions of the expansions; ‘B’ panels work with the ‘B’ versions
of the expansions.

\ J

The AxTraxNG™ access control system is a complete server-client software management system for use
with the AC-215/215IP, AC-225/225IP, AC-425/425IP, and AC-825IP access control panels.

The AxTraxNG access control system is user-friendly, intuitive, and rich in functionality. Using AxTraxNG,
you can configure door functionalities based on areas and time frame for different types of personnel and
for varying alarm situations.

The AxTraxNG access control system can integrate with ViTrax™ Video Management Software (VMS)
application. The main purpose of the integration is to enable video recording based on access control
events and convenient playback.

This manual is compatible with AxTraxNG software Version V27.7.x.x.

1.1. AXTraxNG Server and Client

The AxTraxNG system includes both the AxTraxNG Server and the AxTraxNG Client software applications
separately.

Install the AxTraxNG Server on the computer that controls the access control panels and manages the
database.
e ™
The computer should be a dedicated PC for theAxTraxNG server with no SQL entity or any
& non-Windows service existing or installed on the PC.

\ J

. p
& Itis highly recommended that the AxTraxNG Server will be online 24 hours per day.

. J

Install the AxTraxNG client software on any PC from which you wish to access the system. One AxTraxNG
server can serve an unlimited number of AxTraxNG clients.

AxTraxNG is based on a standard Client-Server architecture:

AxTraxNG™ V27.7.x.x User Guide 8
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1. Introduction

* Only the server connects to the database; the clients gather the information from the server
* Panels are connected to the server using a serial (RS-485) or LAN/WAN communication

* The server runs as a Windows service by default

AxTraxNG™ V27.7.x.x User Guide 9
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2. Specifications and Requirements

2. Specifications and Requirements

2.1. System Capabilities

Software Architecture Client-Server
Database Type SQL Server Express 2008,2012
® 30,000 per panel (AC-215IP, AC-215B, AC-225, AC-425)

Max. Number of Credentials * 5000 (AC-215)

® 100,000 (AC-825IP)

Max. Access Groups Based on the maximum number of users, 30,000 x the number of panels
Max. Number of Time Zones 128 (256 with AC-825IP)
Max. Credentials per User 16
Max. Access Control Panels and

. 1023
Expansions

® Timed

Antipassback * Door

Global — across the entire facility

International Holiday Support Up to 64 holidays

NEIS

Max. Number of Networks Up to 1023 (depending on network topology)

AxTraxNG™ V27.7.x.x User Guide 10
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2. Specifications and Requirements

¢ AC-215B,AC-215IP-B
¢ AC-225B, AC-225IP-B
¢ AC-225B, AC-225IP-B with MD-1084B
¢ AC-225B, AC-225IP-B with MD-D02B
® AC-425B, AC-425IP-B
¢ AC-425B, AC-425IP-B with MD-1084B
¢ AC-425B, AC-425IP-B with MD-D04B

® AC-825IP

Supported Access Control Panel

R805, S-805, D-805, P-805
Models

Legacy: AC-215, AC-215 (SPV), AC-215IP
Legacy: AC-225, AC-225IP

® Legacy: AC-225, AC-225IP

® Legacy: AC-225, AC-225IP with MD-1084
® Legacy: AC-225, AC-225IP with MD-D02
® Legacy: AC-425, AC-425IP

® Legacy: AC-425, AC-425IP with MD-1084
® Legacy: AC-425, AC-425IP with MD-D04
® Serial (RS-232/485)

* TCP-IP
Panel Networks

Communication Interface

A AC-825IP has TCP/IP only

Communication Speed 9600, 19200, 57600, and 115200 bps
2.2. System Requirements

2.2.1. AxTraxNG Server and Client Requirements

Operating System Windows 8.1 (recommended), Windows 10 (64-bit), and server editions

AxTraxNG™ V27.7.x.x User Guide 1



2. Specifications and Requirements

Minimum: Intel dual core 2.4 GHz or equivalent
Processor
Recommended: Intel core i5 ori7 CPU
Minimum: 2 GB
Memory
Recommended: 8 GB
Network LAN card required for TCP/IP networking
Hard Disk Space 5 GB minimum

2.2.2. Microsoft Framework

You must have Microsoft .NET Framework 4.0 or above installed on your PC.

AxTraxNG™ V27.7.x.x User Guide
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3. Installation

3. Installation

The AxTraxNG installation setup file consists of the following four main components:

AxTraxNG Client
SQL Server

AxTraxNG Server

= The AxTraxNG Client is only needed on the main computer; however, it can be installed on
additional computers.

AxTraxNG Server Monitor

(Optional) ViTrax software — Enables video integration

3.1. Downloading the AxTraxNG Installation File

Install the AxTraxNG access control software on the computer that connects to the access control panels
and manages the database.

To Download The AxTraxNG Installation File:

1.

2
3.
4

Go to http://www.rosslaresecurity.com.

Login to your account.
Click Download Center in the Quick Links section.

In Product, select AX-NG AxTraxNG PC Client/Server Management Software.

Product

- Select —
AX-NG AxTraxNG™ PC Client/Server Management Software k

Ax-TM AxTime™ Time & Attendance Client Software

The image above to be changed. This image is for "AxtraxNG".
In Document Types, select Software and click Search.

In the search results, you'll see AxTraxNG software.

ﬁ Private: AxTraxMNG AX-MNG AxTraxNG™ PC
software Client| Server
Management Software

The image above to be changed. This image is for "AxtraxNG".

AxTraxNG™ V27.7.x.x User Guide 13
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6. Click the Download icon on the right.

The installation file is downloaded to your computer.

3.2. Beginning the Installation
Once you have downloaded the installation file, you can begin the installation.
To Begin The Installation:

1. Browse to the downloaded file and double-click it.

After the necessary files are extracted, the following screen opens:

ﬁ MG_Prerequisite - InstallShield Wizard X

Welcome to the InstallShield Wizard for
NG_Prerequisite

The InstallShield(R) Wizard will install MG_Prerequisite on your
computer. To continue, dick Mext.

YWARMNIMG: This program is protected by copyright law and
international treaties.

2. Click Next, and the following screen will appear:

= In some cases the installation will require a PC restart, and after the restart double click on
the installation file once more.

AxTraxNG™ V27.7.x.x User Guide 14



3. Installation

Figure 1: AxTraxNG Packages Selection Screen

AxTraxNG Installation Version 27.7.0.2 EI
AxTraxNG Server and Client Requirements: Software of any kind provided with or as part of the product is provided explicitly "as is", within an
explicit denial of all wamanties, expressed or implied (including, without limitation, wamanties of

Operating System Windows 7 (32/64 bits) SP1 merchantability, non-nfingement, orfitness for a particular purpose), but nevertheless, Rosslare
Minimum: Intel Dual core 2.4 GHz or Equivalent guarantees that the software to be free from defects for a period of ninety (30) days after delivery. if

Processor Recommended: Intel core i5 ori7 CPU any defect appears within the wamanty period, you can contact Rosslare to receive replacement
Minimum: 2 GB software free of change at the discretion of Rosslare. Rosslare does not wamant and has no

Memary . X responsibility for the accuracy or completeness of any information, text, graphics, links, or other items
Recommended: 8 GB contained within the software.

Network LAN card required for TCP/IP networking

Hard Disk Space 5 GB minimum [ s

S0L- Server Express Requirements: Select yourinstallation configuration and press Start button

Processar Pentium 4 or better P TraxNG Server with Server Monitor

Memary 2GB AxTrax I

Hard Disk Space 4GB AxTimeNG

Start Close
3. Select| agree and select which packages you wish to install.
s )
= This screen remains open in the background as various elements of the software are
installed.
N Y,
4. Click Start.
e A
= Upgrading to a newer version only uses current database information.
After upgrading the AxTraxNG version, check the panel's firmware version for both old and
new installations and upgrade your firmware if required.
If there is no SQL server installed, the Installation Requirements screen opens.
N Y,
e A
= This screen remains open in the background as various elements of the software are
installed.
_ J

5. Accept the full licensing agreement and click OK.

3.3. Installing AxTraxNG Client

If you are upgrading, the following screen opens:

AxTraxNG™ V27.7.x.x User Guide 15



3. Installation

AxTraxNG Server uninstallation (23]

Before uninstalling your current version of AxTraxMG, it is recommended to back
up the current database.

Click Cancel to exit the installation and back up the database or click OK to
continue without backing up the database,

| ok | [ Cancel

If you are installing for the first time, the following screen opens:

15} ATraxNG Client - InstallShield Wizard (=23

Welcome to the InstallShield Wizard for
AxTraxNG Client

The InstallShield(R) Wizard will install AxTraxMNG Client on your
computer. To continue, dick Next.

WARMIMNG: This program is protected by copyright law and
international treaties.

< Back I MNext > I [ Cancel

To Install The AxTraxNG Client Application:

1. Click Next to begin the AxTraxNG Client installation process.
2. Follow the onscreen instructions to install the application.

3. Click Finish to complete installing the AxTraxNG Client.

3.4. AxTraxNG Configuration Tool

Following the AxTraxNG Client installation, a window opens to install the AxTraxNG Configuration Tool.

AxTraxNG™ V27.7.x.x User Guide 16



3. Installation

AxTraxMG Configuration Tool - InstallShield Wizard

Welcome to the InstallShield Wizard for
AxTraxNG Configuration Tool

The InstallShield{R) Wizard will install AxTraxMNG Configuration
Tool an your computer, To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

| < Back |I Mext = ] [ Cancel

To Install The AxTraxNG Configuration Tool:

1. Click Next to begin the AxTraxNG Configuration Tool installation process.
2. Follow the onscreen instructions to install the application.

3. Click Finishto complete installing the AxTraxNG Configuration Tool.

3.5. SQL Server Setup

Following the AxTraxNG Configuration Tool installation, a window opens to install the SQL Server.

= If youare upgrading from a previous version, you will not see this screen.

AxTraxNG™ V27.7.x.x User Guide 17
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Options
@ Continue AxTraxNG Server installation

(7 Custom {the user can either use an existing instance and database or create a new one)

Instances Database
MName Server Instance Version Is Local
ROSSLARET-SRVAWWIZSOFT2012 | ROSSLARET-SRV |\WIZSOFT2012 | SQL 2012
ILANIT-PCAWERITRAX ILANIT-PC VERITRAX S5QL 2005
SAM-PCT\WERITRAX SAM-PC1 VERITRAX 5QL2012
ISSAC-LENOVO ISSAC-LENOVO
Server Name Instance Name [W] Database New
(focal || | | | [Fest ]
Authentication User Name Password
|Windows Authertication - ‘ | | ‘ |

() Skip the SQL Server 2012 installation {does not install SGL Server 2012 and uses instance cumently associated to AxTraxNG)

The AxTraxNG Server operates using an SQL server 2008/2012 database.

There are three options in installing the SQL server:

1. Select Continue (default) to install Microsoft SQL Server Express 2012.

2. Select Custom to use an existing instance of the SQL 2008 server available on your computer network
with your SQL login credentials.

3. Select Skip to use the current AxTraxNG SQL Server instance.

3.5.1. Default Setup

To Install The Default SQL Server Application:

1. With the default option chosen by default, click Go.

Follow the onscreen instructions to install a new instance of SQL Server 2012. A confirmation sentence
appears on the lower part of the screen when the process finishes.

Microsoft SQL-Server 2012 Bxpress successfully installed.

2. Click Done.

AxTraxNG™ V27.7.x.x User Guide 18
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3. Installation

3.5.2. Custom Setup

Select Custom to use an existing instance of the SQL 2008 server available on your computer network with
your SQL login credentials.

To Install An Existing Instance Of The SQL Server Application:

1. Select Custom.

A list of existing SQL instances are listed in the table.

Instances

Name Server Instance Wersion Is Local -
SAM-PCTWERITRAX SAM-PC1 VERITRAX 11.0.2100.60 H

ILANIT-PC\VERITRAX ILANIT-PC VERITRAX  |9.00.4035.00
ROSSLARE1-SRWWBKUPEXEC | ROSSLARE1-SRV | BKUPEXEC | 9.00.5000.00

ROSSLARE1-SRVWWIZSOFT | ROSSLARET-SRV | WIZSOFT 9.00.5000.00

Server Name Instance Name New Database New

[toca | | | | | [(Reset ]
Authentication User Name Password
|Wind0ws Authentication A | | | | |

If you do not see the table, you receive the following message instead:

fﬁl

To see all 5QL instances currently installed on the SQL server (locally or remotely],
the service 50JL Server Browser must be running.

oK

You need to enable the SQL Server Browser service and start it, and then click Refresh.

2. Select the instance from the table that you wish to use.

AxTraxNG™ V27.7.x.x User Guide 19
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3. Enter all field information as needed.

A setup wizard for the SQL Server 2012 Express opens.
e A
= The password must meet the Microsoft SQL Server Strong Password requirements:

* Does not contain all or part of the user's account name
* Is more than eight characters in length

* Contains characters from at least three of the following categories:

* English uppercase characters (A through Z)
* English lowercase characters (a through z)
* Base 10 digits (0 through 9)

* Non-alphabetic characters (for example: !, S, #, %)

= * If installed SQL server instance has SQL Server Authentication, installing a new instance
with Windows Authentication is impossible.

* When creating a new instance, be sure that the instance name is different than the
existing instance name.

* The new instance is created with System Administrator rights (User ‘SA’). To create an
instance with limited rights, please ask your DB Administrator.

4. Click Go.
A setup wizard for the SQL Server 2012 Express opens.

3.5.3. Using Current SQL Server
Select Cancel to use the current SQL Server instance.

To Use The Current Instance Of The SQL Server Application:

@ Skip the SQL Server 2012 installation (does not install SQL Server 2012 and uses instance cumently associated to AxTraxNG)
1.

2. Click Go.

The installation continues.

AxTraxNG™ V27.7.x.x User Guide 20
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4. Installing AxTraxNG Server Software

Following the SQL Server Setup installation, the AxTraxNG Install Shield Wizard for the AxTraxNG Server
software installation appears.

Walcome to the InstalShiekl Wizard for
AxTrachi Server

Fhe IrtalEiaeldR] wirard sl ratall AxTe ol Torver on your
compuier. To oonbrue, chok bet.

WARNING: This program i protected by copright law and
rRematonal eates,

To Install The AxTraxNG Server:

1. Click Next to begin the AxTraxNG Server installation process.
2. Follow the onscreen instructions to install the application.

3. Click Finish to complete installing the AxTraxNG Server.

4.1. Installing AxTraxNG Server Monitor

Once the AxTraxNG server installation finishes, the AxTraxNG Server Monitor installation opens
automatically.
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5] AxTraxNG Server Monitor - InstallShield Wizard =

Welcome to the InstallShield Wizard for
AxTraxNG Server Monitor

The InstallShield(R) Wizard will install AxTraxMG Server Maonitor
on your computer. To continue, dick Mext.

WARMIMG: This program is protected by copyright law and
international treaties.

< Back £ Mext = 4 [ Cancel

To Install The Server Monitor:

1. Click Next to initiate the AxTraxNG Server Monitor installation process.
2. Follow the onscreen instructions to install the application.

3. Click Finish to complete the Server Monitor installation and to launch the application.

4.2. Completing the Installation

Once all the elements of the installation have completed, a confirmation screen appears.

=5

Installation finished!

1. Click OK.
2. Click Close onthe AxTraxNG Packages Selection Screen (Figure 1: AxTraxNG Packages Selection
Screen).
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3. Check that you see a message in the Windows system tray that the server is connected.

Server connected B (4]

R MEBP OLY 11:59 AM

4.3. Firewall Settings

Internal firewall settings may prevent the AxTraxNG Server from connecting to the SQL database or to
panel control units using TCP/IP and remote Server-Client connection.

For more information on how to configure a firewall, see Appendix Firewall ConfigurationContact your
system administrator or Rosslare Technical Support for further guidance.

4.4. SQL Server Settings

After installing AxTraxNG, verify that the SQL server service on the computer is running and set to the
required installation.

For more information on SQL server settings, see Appendix Opening a Program in Windows' Firewall.

= If SQL Express 2012 is being installed (part of the installation package), the installation must be

on the same Windows user account that is being used for AxTraxNG.
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5. Software Overview

AxTraxNG is controlled through a user-friendly interface, and comes with a Tree View list of all aspects of
the site setup and a toolbar for standard operations.

=1 Starting from v25.xx, AxTraxNG is based on WCF technology and allows running the client via
a WAN (Internet) connection.

5.1. Starting the Software - Local PC

This section explains how to start the software and log in to the main window.

To Start AxTraxNG:

1. Double-click the AxTraxNG Clienticon () on the desktop or select the program from the Rosslare
folder in the Start menu.

The Logon AxTraxNG Client dialog box appears.

Logon AxTraxNG Client V27.7.1.2
* Please check name and enter password

Operator name
|Mmhistrator w |

Password
[ |

[ ok ]| Cancel |

2. Select an Operator name and enter a Password.

{ = By default, the Administrator operator password is "admin". J

3. Click OK.

The main AxTraxNG window opens.

5.2. Starting the Software - Via WAN Connection

Starting from v25.xx, AxTraxNG is based on WCF technology and allows running the client via a WAN
(Internet) connection. However you must first define the server and client connections using the AxTrax
Configuration Tool.
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To Start AxTraxNG Using The AxTraxNG Configuration Tool:

1. Click AxTraxConfigTool (ﬁ) from the AxTraxNG Client folder under the Rosslare folder in the

Start menu.

The AxTraxNG Configuration Tool opens.

AxTraxNG Configuration Tool

Eile

Configuration File:  C:\Program Files (x86)\Rosslare'\AxTraxNG Server\AxtraxService.exe.config

i

X

Server

Client

Server Monitor
LFR

AxTime

Services

- Communication Services

LPR Services

Host Name: localhost

Port: 1003

Server Connection:

Host Name: localhost

Port: 1001

Ci\Program Files (x86)\Rosslare\AxTraxNG Server\AxtraxService.exe.config

1. Under the Server tab, enter the LPR and the Server Connection ports. If you are not using LPR, leave the

default value.

2. Select the Client tab.
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AxTraxNG Configuration Tool - 8 X
Eile

Configuration File: C:\Program Files (xB6)\Rosslare\AxTraxMG Client\Client.exe.config & = | x

Server Clients
| Client

Server Monitor
LPR
AxTime

- LPR Services
Host Name: localhost ‘

Host Name: localhost

r Server Services ‘

C\Program Files (xB6)\Rosslare\AxTraxNG Client\Client.exe.config

3. Inthe Hostname field, enter the IP address of the Client server.

As soon as you enter the IP address, the Port field appears.

Clients

~ LPR Services

Host Name: 192.0.0.13

Port: 1003

- Server Services .

Host Name: |ocalhost

4. Enter the same port number as you did in the Server Connection field above.

5. For the Server Monitor, LPR, and AxTime tabs, enter the same IP address and port number in the
respective fields.

6. When you finish populating all the fields, click the Save All button ( @ ) on the toolbar.
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7. Close the Configuration Tool.

8. Now double-click the AxTraxNG Client icon () on the desktop or select the program from the
Rosslare folder in the Start menu to see the login window as seen above in Section Starting the Software
- Local PC.

For more troubleshooting with a server connection, refer to Appendix WAN Connection Troubleshooting.

5.3. AXTraxNG Main Window

The entire central functionality of the AxTraxNG system is available from the AxTraxNG Client main
window (Figure 2: AxTraxNG Main Window).

Figure 2: AxTraxNG Main Window

E IAX<TRANG

Nccess THe muTURE

The AxTraxNG Client Main window is divided into six sections, as described in the following table:

Section Description

The Menu Bar controls the software’s general operation and setup. For more

1 Menu Bar . . .
information, see Section Menu Bar.

The main toolbar consists of icons for the key tasks required in managing access
2 Toolbar control across a facility. The available icons change according to the view selected.
For more information, see Section Toolbar.

The Tree View allows users to configure, monitor, and control every aspect of access

3 Tree View . . . .
control. For more information, see Section Tree View.

The Display Area displays all items within the selected Tree View element. It also
provides options to add, edit, or delete items manually without opening the detailed

4 Display Area element windows.

In addition, the Display Area provides various system updates.

The Event Log displays a detailed log of every time access was granted or denied for
every door on the site, as well as when inputs and output are opened or closed. The
5 Event Log event log toolbar consists of icons allowing the user to monitor potential door
tamper or forced entry attempts. These warnings are logged and displayed as
internal system warnings.
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Section Description

6 Status Bar The Status Bar displays server connection status and the server time.

5.4. Menu Bar

The menu bar controls the general operation and setup of the software.

5.4.1. File Menu

The File menu has three options:

Server Connection Log on to the AxTraxNG server (See Section Starting the Software — Local PC)
ViTrax Server Log on to the ViTrax server
Exit Exit the AxTraxNG software

5.4.2. Tools Menu

Use the Tools menu to manage the database and set software preferences. The menu has four options:

Menu Select Menu Item To...

Open the Database window to back up the database or set a scheduled
Database backup, as well as to import or export the AxTraxNG and/or AxTrax AS-525
configuration states and events logs (see Section Maintaining the Database)

Set software options and preferences, including national holidays, event
Options highlighting, custom user information fields, and GUI language (see Section
AxTraxNG Options and Preferences)

Import/export user information from/to an Excel spreadsheet file (see Section

Import/Export Data . .
Importing/Exporting User Data)

Create a conversion table that converts the alphanumeric character to a

Conversion Tables . . .
binary number (see Section Conversion Table)

5.4.3. View Menu

Use the View menu to define and manage the view of the GUI. The menu has four options:

Events Select the option to show event logs

Table View Select the option to show the Display Area
Guard Screen Select to show the Guards Screen (if installed)
Restore Docking Restore the default GUI view

5.4.4. Window Menu

The Window menu has three options:
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Help

v  In Corners

Tile

Close All Floating Windows

Place any open pop-up windows in the corners of the screen. This option is
chosen by default.

In Corners

Tile To move any opened pop-up windows to available space on the screen
Close all of the pop-up windows

Close All Floating Windows
You can use the list of open pop-ups to focus on any open pop-up window.

5.4.5. Help Menu

The Help menu has four options:
5.4.5.1. About

The About window displays software, firmware, and database versions, the current operator, and licensing
information.

About B
AxTraxNG Access Control System
B e
~ Software: 27712
Fimnware: ac215v04_08_23 Bootioader bil_ac215IPv3_00
ac215Bv05_01_12 bil_ac225v_01_02
ac225v05_01_T2 bil_ac425v_02_01
ac425405_01_12 btl_Rev.B vD4 01
ac825v02_09_13 bil_acB25v_0_04.._02 05

SQL Server database n

Curent operator: Administrator
Lcense
License erder number None
AxTime: Disabled
Maximum number of readers: 256
Maximum number of biometric readers: k7]
Maximum number of HikVision DVR servers: Disabled
Maximum number of Hik Vision cameras: Disabled
Maximum number of Dahua DVR servers: Disabled
Maximum number of Dahua cameras: Disabled
Attendance DAT report- Disabled

Copyright® 2019 - Rosslare Enterprises Ltd.

Warming: ‘Tln computer program

Unauthorized reproduction or disrbution of this program. or any porbon of &, may resut in severs G and ciminal penaltes.
and will be prosecuted to the maxamum extent possible under law.

| LICENSE AGREEMENT Release Notes

5.4.5.2. User Manual

Clicking User Manual opens the user manual for AxTraxNG.
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5.4.5.3. Regqistration

The Registration window is used to register your AxTraxNG license.
To Read Plan Details And The License Agreement:

1. Click the General tab.

To Register The Product:

1. From the menu bar, select Help > Registration.

The Product Registration window opens.

000A-42B81-2EBD-4B4A-E353-5F85

License File

Activate |

The Hardware ID is automatically populated.

2. Un-zip the license file you received from Rosslare by email and place the file (xxx.license) on your PC
where it can be easily accessed.

Once your license is activated, the licensing information in the About screen (Section About) is updated.
5.4.5.4. Feedback

Use the form on the Feedback window to send feedback to Rosslare.
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-
= Inorder to use the Feedback form, you must configure the SMTP settings (see Section
Options).
\_
Feedback
&
—
—
ST Y PRODUCTS
Please fill in your requests or comments:
- Support Email
iPlease selact a region vl
r Contact Info
Name | ‘
Company | ‘
Email | ‘

5.5. Toolbar

The toolbar controls key tasks required to manage access control across an entire facility. When a new
element is selected from the Tree View, the toolbar icons change to suit the selected element.

The following toolbar icons are available:

5.5.1. General Icons

Icon Name Click Icon To...

' Manual Door Open the Door Manual Operation window (see Section Controlling the Door
Operation Manually)

E Print

Send the current Display Area view to the printer
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Icon Name Click Icon To...

+ Add Add a new element of the selected type
F] Edit Edit the selected element

x Delete Delete the selected item

5.5.2. Network Icons

Icon Name Click Icon To...
- ) Set the time on the selected access control panel (see Section Setting the Time
{,_J' Set Time
and Date)
) Find and update panels within the network (see Section Searching for Existing
Find Panels
Access Control Panels)
Add available panels and panel components to the Status Map (see Section
Add to Status Map
Status Map)
Reader Type Configure custom reader type
%I Camera View a list of connected cameras and link cameras to AxTraxNG
5.5.3. Panel Icons
Icon | Name | Click Icon To...
Change the operation mode of the readers on the selected panel (see Section
Manual Reader .
Changing the Reader Mode)
. Send a firmware update to the selected access control panel (see Section
P Update Firmware . .
Updating Firmware )
+ Control Output Change the settings for the outputs on the selected panel (see Section
— Manually Controlling Outputs Manually)
3 Control Input Change the settings for the inputs on the selected panel (see Section Manually
— Manually Disarming Inputs)
Control Siren
.3 Test the siren for the selected panel (see Section Controlling Sirens Manually)
Manually
@ Reset Panel ) . .
Reset a panel command sent to the panel in case of misbehavior
Manually

5.5.4. Biometrics lcons

Icon Name Click Icon To...
¢ Import Import Biometrics terminal from a remote network (see section 5.8.2)
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Icon Name Click Icon To...

= . Send a firmware update to the selected access control panel (see Section
e Update Firmware ) .
Updating Firmware )

5.5.5. Card\Users Icons

Icon Name Click Icon To...

E
l,'-_1) User Counter View the current user count value (see Section Testing User Counters)
.'. Add Users and Create up to 1000 new users and cards in one batch (see Section Auto
l'.'.. Cards Opening for Output Groups)
m Card List Batch add specific cards to a specific user
EF.,.‘ Add Cards Create up to 1000 new cards in one batch

Add Cards from Add and assign cards to selected users or add cards from a desktop reader

Desktop reader (see Appendix Enrolling a User’s Fingerprint)

Print a card template that has been created (see Chapter Card Design (Photo

2 |
@ Print Cards ID)).
Q

Filter the list of users by various parameters, such as name and card number

User Filter . .
(see Section User Filter)

Find the make of your car to add to Vehicle Types when configuring a License

ﬁ Manufacturer Brand . ) )
Plate Recognition (LPR) camera (see Section Vehicle Types)

5.5.6. Reports Icons

. Manual Door Open the Door Manual Operation window (see Section Controlling the Door
Operation Manually)
':-‘ Print Print the current report
’ﬂ‘ Save Reports View report criteria previously saved in the Display Area
L Run Produce a report from the selected report type and criteria (Chapter Reports)
Preview Preview a report that was just run
E Save Save the report criteria used to generate reports
IEI Delete Delete a saved set of report criteria used to generate reports
33
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5.5.7. Events Toolbar Icons

When clicking an event icon, click the dropdown arrow to change the current view of the display.

Icon

Name

All Events Online

Click Icon To...

Display all real time events

Panels AC Display all event types uploaded from the access control units

Access Display only access events uploaded from access control units

Alarm Display only alarm events uploaded from access control units

Archive Display video stream archive events stored in either the ViTrax database, the
USB key, or snapshots saved on PC

System Display events related to the AxTraxNG Server operation and operators activity

Biometrics Displays events from the Biometric terminals

Cameras Displays events of recorded streams from a camera

Pause Halt the display of events in the Display Area. New events are shown again
when the Pause button is clicked a second time.

Refresh Manually refresh the event list

View Events within
the last Hour

Display all events that occurred within the last hour. Click the dropdown arrow
to change the view.

View Events within
the last Day

Display all events that occurred within the last day

View Events within
the last Week

Display all events that occurred within the last week

View Periodical
Events

Display all events that occurred within a selected period

View All Events

Display all events

Clear List Clear the entire log and empty the current event list view
Show User Open the User window for the selected user.
Clear Alarm Open the Alarm Details window to allow the operator to reset the alarm.

[ B ve| | (] | 5| CE| | W = L0 R
(=) &% o e )]

Antipassback
Forgive

Open the Antipassback Forgive window to allow the operator to cancel an
Antipassback restriction for the selected user.
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Icon NETN Click Icon To...

%l Camera List Open a list of all ViTrax cameras attached to the network

ST,

L_L'T Archive Open the Archive Camera window for the selected video stream or snapshot
and play the stream

Opens the Car Parking Counters window to view and edit the car parking area

= Car Parki
P arrarking and group counters.

5.6. Tree View

The Tree View allows users to configure, monitor, and control every aspect of a facility's access control
network.

When the user selects an element from the Tree View, its contents are shown in the main Display Area, and
the toolbar icons change to suit the selected element.

5.6.1. AC Networks

A network is a group of up to 32 access control panels. The AxTraxNG Server connects to the panels
across the panel network.

For more information, see Section Adding a Network.

= Over a certain amount of readers, you must activate you license file (see Section User
Manual).

5.6.2. Biometrics

The Biometrics element allows you to manage biometric terminals.

For more information, see Section Adding a Biometric Terminal.

5.6.3. Video Integration

Cameras can be added to the network to allow real-time viewing of any area desired. The Video
Integration element allows you to add cameras from ViTrax, Hikvision, and Dahua servers to the network
and to configure each camera’s settings (Chapter Video Integration).

5.6.4. Timing

The Timing tree branch consists of two elements: Time Zone and Holidays.
5.6.4.1. Time Zones
A time zone defines a weekly time period or set of time periods; for example, "Office Hours" or "Out of

Office Hours". Door access rights, alarms, and input and output behavior can all be set to behave differently
within each Time Zone (see Section Adding Time Zones).
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5.6.4.2. Holidays

This element defines annual holiday dates; it is possible to set special access behaviors for holiday time
(see Section Adding Holidays).

5.6.5. Groups

The Groups tree branch consists of the following elements: Access Groups, Access Areas, Output
Groups, Input Groups, Card + Card Groups, and Vehicle Access Groups.

5.6.5.1. Access Groups

An Access group defines when each reader on the site is available for access. All site personnel are
assigned to appropriate Access Groups.

For more information, see Adding Access Groups.

5.6.5.2. Access Areas

A facility can be subdivided into several access areas to configure and manage it more effectively (see
Adding Access Areas).

5.6.5.3. Input and Output Groups

Input and Output groups define sets of outputs or inputs that should be managed together within a panel
(see Adding Input Groups and Adding Output Groups).

5.6.5.4. Card + Card Groups

Card + Card mode is a secure mode that requires two card holders (users) to grant access to a particular
reader (see Defining Card + Card Groups).

5.6.5.5. Vehicle Access Groups

The Vehicle Access Group is used for defining cars for LPR.

The functionality will be discussed in future versions of the manual.

5.6.6. Global Antipassback

Antipassback rules can be applied to each access area to prevent one user's card or entry code from being
used for two subsequent entries, and to prevent a second entry without a previous exit (see Section
Associating a User to a Card).

5.6.7. Car Parking

The Car Parking management option allows you set up groups with a limited number of users who can
access a particular area. This feature is counter based that keeps track of the number of usersina
specified area.

For more information, see Section Adding Car Parking.
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5.6.8. Users

The Users tree branch consists of five elements: Departments/Users, Visitors, User Filter, Cards, Vehicle
Types, and Operators.

5.6.8.1. Departments/Users

This element shows a list of all departments and users, as well as any visitors registered in the system.

Each user is a member of a department. For each user, it is possible to assign cards and/or a PIN code,
set access rights, personal details, and include an identification photograph.

For more information, see Section Adding Departments, Users, and Visitors.
5.6.8.2. Visitors

This element shows a list of all visitors registered in the system.

Visitor type users can also be created with specific access rights.

For more information, see Section Auto Opening for Output Groups.

5.6.8.3. User Filter

This element allows you to find users in the database based on various search parameters, such as name,
user number, and access group. The filtered list then appears in the main window.

5.6.8.4. Vehicle Types

This element shows a list of car types that can be used when adding LPR configuration.

The functionality will be discussed in future versions of the manual.

5.6.8.5. Cards

This element lists all cards in the system with their statuses, and allows the manual addition of cards to the
system (see Section Auto Opening for Output Groups).

Cards can also be added to the system using an MD-08/Desktop Reader reader (Appendix Enrolling
Credentials using a Desktop Reader).

In addition, the element allows you to create a card template for printing (see Chapter Card Design (Photo
ID)).

5.6.8.6. Operators

Operators are people with access to the AxTraxNG software. The default operator names are
Administrator, Engineer, and Security.

Different operators have wider or more restricted security rights, from complete control over the system
to the ability only to view one section. All Operator passwords are case sensitive.

For more information, see Section Adding Operators.
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5.6.9. Status Map

The Status Map creates a graphic display of the statuses for every door, reader, and alarm in the facility on
user-selected images.

The system can display multiple nested status maps, allowing users to show either the complete access
control network or a specific area in detail.

For more information, see Section Creating Status Maps.

5.6.10. Reports

AxTraxNG can produce various reports, including usage reports, attendance records, visitors, and roll
calls. The AxTraxNG Report Wizard allows users to design their own custom reports based on their needs.
For more information, see Chapter Reports.
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6. Setting Up a Site

This section outlines arecommended step-by-step process for configuring AxTraxNG for a site.

Step
1

2
3

10
11

12
13

14

15

16
17
18
19

| Action
Add Time Zones

Add Holidays
Add a Network

Add and Configure
an Access Control
Panel

Add an Expansion
Board

Configure the Doors

Configure the
Readers

Adding Biometric
Readers

Configure the Inputs
Add Panel Links

Add Video
Integration

Adding Groups
Add Access Areas

Add Departments,
Users and Visitors

Add Global
Antipassback Rules

Add Car Parking
Add Operator

Add Elevator Control
Add a Status Map

| Section

Adding Time Zones
Adding Holidays
Adding a Network

Adding Access Control Panels

Adding an Expansion Board
Configuring the Doors

Configuring the Readers

Adding a Biometric Terminal

Configuring the Inputs
Adding Panel Links

Adding Video Integration

Adding Groups

Adding Access Areas

Adding Departments, Users, and Visitors

Adding Global Antipassback Rules

Adding Car Parking
Adding Operators
Creating Elevator Control

Creating Status Maps

The AxTraxNG system performs an automatic data download for any parameter related to the hardware.
If panels are connected and active, a download count appears on the status bar after any downloaded
parameter change.

6.1. Adding Time Zones

A time zone is a group of periods within a week. Door access rights, as well as alarms and input and output
behavior, can all be set to behave differently for each time zone. Many operations can be automatically
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enabled or disabled within a selected time zone.

The Time Zone Properties window displays the selected periods for each day of the week.
To Add A New Time Zone:

1. Inthe Tree View, select Timing > Time Zone.

2. Onthe toolbar, click the * icon.

The Time Zone properties window opens.

Time Zone (=]
Time Zone 4

Sunday Maonday Tuesday Wednesday Thursday Friday Saturday Haoliday [ -

08 ®

09 *

o0

10 ™

11%

12%

13 ™

KN

14 %

on

157

1 6 oo

17 @

18 %

New || ok ][ Cancel

Enter a name for the time zone.

Click and drag the mouse down a day column to select a time interval.

3

4

5. Right-click the selected area and select Create.

6. Right-click the selected area again and select Properties to fine tune the time frame and then click OK.
7

Repeat Steps 4 to 6 for each day. Up to 16 intervals can be added per day.

' You can move a defined time zone to a different day and time using drag and drop.

AxTraxNG™ V27.7.x.x User Guide 40



ROSSILNR= 6. Setting Up a Site

8. Click OK when all of the time zones are defined.

= AC-215A control panel can support up to 8 time intervals for each day.

6.2. Adding Holidays

You can add and define annual holiday dates on which it is then possible to set special access behaviors.

There are two ways to add holidays:
* Add a known national holiday(s)

* Add anew holiday

To Add A National Holiday:

1. Inthe Tree View, select Timing > Holidays.

2. Onthe toolbar, click the icon.

The Outlook Holidays window opens.

M

Select holidays to import

[ Christian Refigious Holidays
Colombia

-] Croatia
-] Czech Republic

- Egypt

H -
[ Ectamin

ok | | Cancel

3. From the list, find the relevant country and either:
a. Select the main check box to select all holidays for that country.
b. Expand the check box and select which holidays to add.

4. Click OK.
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To Add A New Holiday:

1.

N o o M

Inthe Tree View, select Timing > Holiday.

On the toolbar, click the + icon.
The Add Holiday window opens.

m
Description

Holiday 3

Enabled

Date 3 7208 El-
Every Year

ok J[ cones

In Description, enter a name for the holiday.

Select Enabled to enable the holiday.

Use the Date drop down to select the holiday’s date.
Select Every Year to repeat the date yearly.

Click OK.

6.3. Adding a Network

A network consists of one or more access control panels. AxTraxNG communicates with each access
control panel in the network.

The Network window includes the following information:

* The network's name, address, and activation status

* The DIP switch settings for the communication speed (non-AC-825IP panels)

* The type of network connection and the connection settings

* Type of panel and its hardware (AC-825IP only)

® Time zone used by the network

When adding a network, you must choose the type of access panels that are added to the network.
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6.3.1. AC-215x, AC-225x, and AC-425x Panels

To Add A Network For AC-215x, AC-225x, And AC-425x Panels:

1. Inthe Tree view, select AC Networks.

2. Onthe toolbar, click the + icon.

The Network window opens.

Metwaork

General Options

(=]

Description

Metworl 1

Enabled
AC Type

[FC—215.3215IPKF{215&?225I225W425£425E1

Metwork Type

| Seial

Seral Metworl

COM Port

[ v
Speed

3600 v

—

11345678

A The display varies according to the type of network selected.

\.

3. InDescription, enter a name for the new network.

4. Select Enabled.

[ =1 If Enabled is not selected, communication to panels on the network is halted.
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5. In AC Type, select AC-215/2151P/215B/225/225B/425/425B.
6. In Network Type, select the network type and set the connection settings:
a. For serial, select the correct COM port and speed.

b. For a TCP/IP network, enter the IP address, select the port and speed, and select whether the
network is WAN or LAN.

7. If you do not know the connection settings:

a. For a TCP/IP connection, click Configuration to locate the hardware on the local network.

Refer to Appendix Configuring a Network for how to configure an access control network. Check with
your system administrator for more information or contact Rosslare technical support.

= Access control panels connect to a TCP/IP network via an MD-N32 Serial to Ethernet
Gateway or by using the onboard module in the AC-225IP or AC-425IP. Refer to the relevant
hardware installation guides for more details.

8. For all types of networks, set the DIP switch on the access control panel hardware to match the diagram
at the top of the screen.

S After changing the DIP switch, make sure to power down and then power up the panels.
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9. Inthe Network window, select the Options tab.

Metwork (=]

Optons

@ Panel network using A« TraxNG Server time zone

(71 Panel network using differert time zone

10. To use the time zone of the AxTraxNG Server for the panel network, select Panel network using
AxTraxNG Server time zone (default), and then continue to Step 13.
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11. To select a different time zone for the panel network, select Panel network using different time zone.

The Network Time Zone section appears.

i@ Panel network using differert time zone

MNetwork's Time Zone
Select Time Zone (Windows Date and Time)

) Panel network using A TraxMG Server time zone

| (UTC+02:00) Jerusalem

Custom Daylight Savings
Daylight Savings Date/Time
Daylight Time
m hh:mm
Start DST ttime)
m hh:mm
Start DST (date)

[] Every Year

Stop DST ttime)
m hih:mm
Stop DST (date)

4/ 3/2017 -

4 3207 E~

12. Set the Daylight Saving Time definitions according to the field descriptions in the following table:

Field | Description

Select Time Zone

(Windows Date From the drop down list, select the desired time zone.

and Time)

Custom Daylight
saving

Daylight Time Select the new hour at the time that daylight saving time begins.

Select to define custom settings.

Start DST (time) Select the hour that daylight saving time begins.

Stop DST (time) Select the hour that daylight saving time ends.

Select Every year to set a day in one of the weeks of a defined month to automatically
begin and end daylight saving time every year.

Every year
Clear Every year to set a date for one-time setting of the beginning and end of daylight
saving time. In this case, a new date must be set each year.

Start DST (date) If Every year is not selected, select the commence date for daylight saving time.

Stop DST (date) If Every year is not selected, select the end date for daylight saving time.
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13.
14.

To save this network/panel and to add another panel, click New.

To save this newtork/panel and exit OK.

6.3.2. AC-825IP Panel

To Add A Network For An AC-825IP Panel:

1.

6.

In the Tree view, select Networks.

On the toolbar, click the + icon.

The Network window opens.

In Description, enter a name for the new network.
Select Enabled.

In AC Type, select AC-825IP.

M

General | Options
Description
Network 1
Enabled
AC Type ALC-825IP Panel
| AC-8251F - Type
Network Type |1 Reader per Door -
[ TCPAP -| Hardware Version
| AC-8251F -
TCP/IP Network
IP Address Primany Port Secondary Port
| 4001 B (4002
Direct MAC address
|m:m:m:m:m:m
) Bemote (WAN)
Local (LAN)
New || oK || Cancel |

Inthe AC-825 Panel area:
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a. From Type, select if the panel is 1 or 2 readers per door.

b. From Hardware Version, select whether this is an AC-825IP panel or one of its expansions
(R/S/D/P-805).

- Once these parameters are chosen, they cannot be changed.

7. Enter the IP address, the primary port, MAC address, and select whether the network is WAN or LAN.

8. If you do not know the connection settings, click Configuration to automatically locate the hardware on
the local network.

For more information on how to configure a TCP/IP connection, see Appendix TCP/IP Connection.
Check with your system administrator for more information, or contact Rosslare technical support.
Clear Enabled if you want to halt communication to panels on the network.

- Access control panels connect to a TCP/IP network using the onboard module in the AC-

825IP. Refer to the AC-825IP Hardware Installation and User Manual for more details.

9. Inthe Network window, select the Options tab and continue with the instructions as described from
Step 10 in Section AC-215x, AC-225x, and AC-425x Panels.

10. Click OK.

6.4. Adding Access Control Panels

6.4.1. AC-215x, AC-225x, and AC-425x Panels

Every network is a cluster of access control panels. Inits standard form, each access control panel can be
configured as either one or two readers per door. Each of the AC-215x and AC-225x panels has two
readers and can be configured as a one or two-door panel. Each AC-425x panel has four readers and can
be configured as a two or four-door panel.

When using an optional MD-D02 (supported by AC-225x) or MD-D04 (supported by the AC-425x) reader
expansion board, each panel has four or eight readers and is configurable as such.

Use two readers per door when one door acts as both the entrance and exit to an area of the site. When
only an entry reader is required, use one reader per door.

For example:
* Use configuration with two readers per door set to IN and OUT to produce attendance reports.

* Use one reader per door configuration to control two doors with an IN reader only (premises will be
exited using a Request-to-Exit (REX) switch or a mechanical door handle only).

= When there is communication with the panel, the Tx and Rx LEDs flash.
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6.4.1.1. Adding an Access Control Panel Manually

You can add an individual panel using the Tree View.

To Add An Indivi

dual Panel:

1. Inthe Tree View, click AC Networks.

2. Select an available network.

3. Onthetoolbar,

The Panel Properties window opens.

click the + icon.

Panel Properties n
General  Antpassback  Options

Description Panel Address '
i [t
Enabled [[] Hide events on this PC

Paned Type Firmware: Version w

1 Reader per Door 2c2258v05_00_01

Hardware Typs Bootloader Vension

ALC-275 B MD-1084B bil_Rev B v04_00

Input Functions Output Functions

Input 1 Dowor 1 REX Output 1 Door 1

Input 14 Door 1 Monitor Output 1A General purpose

input 2 Door 2 REX Output 2 Dioor 2

Input 24 Dioor 2 Maritar Output 28 General pumase

Input 5 Spare Input 5 Output 5 General purpose

Input & Spare Input & Output & General purpose

Input 7 Spare Input 7 Output 7 General purposs

Input 8 Spare Input B Output B General purpose

Input 3 Spare Input 5

£

Test New || OK || Cancel

4. Configure the panel according to the fields described in the following table:

Field Description

Description

Type a description for the panel

Panel Address

Type an address number for the panel

The network's address appears to the left of the panel address. Valid entries
are 1-32.

Enabled

Select to activate this panel

Clear if the panel is not connected

Hide events on this PC

Select to hide events originating from this PC
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Field Description

Panel Type Select one or two readers per door
Hardware Type Select the appropriate panel hardware type

Upon selection of the hardware version, the field displays the current

Firmware Version . .
firmware version

. Upon selection of the hardware version, the field displays the current

Bootloader Version )
bootloader version

Inputs Displays the input connections for the panel

Outputs Displays the output connections for the panel

Click to test if that the panel is correctly connected to the server.

The Test Panel window displays hardware details, including hardware type,
firmware, and bootloader versions, and indicates whether a reader or I/0
expansion board is installed on the panel.

Test

= Make sure that the DIP Switch 3 position on the panel corresponds with its position
demonstrated in the Panel properties window.

5. Click Test.

The Hardware Test window opens and shows the panel details.

i Hardware 3\Panel 2 n!
I Firmware Version: acZ?5Bv05_00_01

Bootloader Version: btl Rev.B v04 00

Hardware Type: AC-225 B

Supervised Inputs: fes

Board: MD-1024B

Add Board Close

< If an expansion board is connected to the access control panel, it appears under “Board”,
and an Add Board button is visible (see Section Adding an Expansion Board).

6. Click Close.

7. Inthe Panel Properties window, select the Antipassback tab.
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Panel Properties ]
Antipassback | Options
Antipassback Severity
Automatic Antipassback Artipassback Severty
[Ne'\fer - @ Hard (glam and access denied)
) Soft (zlam onby)
IN Readers: OUT Readers:
7] Reader 1 7] Reader2
[ Tet || New || ok || cancel |

8. Setthe Antipassback behavior according to the field descriptions in the following table:

Field Description

From the Automatic Antipassback drop down, select the time zone for door

Automatic Antipassback )
antipassback rules to apply.

® Hard - An event is generated and the door does not open
Antipassback Severity
® Soft — An event is generated and the door opens

From the IN/OUT readers list, select the check boxes to apply antipassback
In/Out Reader List restrictions to the readers as needed. The reader antipassback is enabled
when the check box is selected.

9. Inthe Panel Properties window, select the Options tab.
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Panel Properties

General I Antipassback | Options

Events Filtter

Select reported events

ull Upload

Door 5 (OSDP)

User Counter on re-enable the panel
Set new courter

| Start.. | Re-upload all events from pan
Door Intedock

Door 1 Door 2

Dioor 3 Dioar 4

Door 6 (JSDP)

l

10. Setthe recording events behavior according to the field descriptions in the following table:

Field Description

Events Filter

Full Upload

Click Select to open the Events Filter and select the events that this panel
should record. Set the filter's operation method:

® Always Active — Only the selected events are recorded by the panel

® Active when panel disconnected - If the panel is disconnected from the
AxTraxNG server, only the selected events are recorded. When the panel
is connected to the server, all events are recorded.

Note: In the default configuration, some events are filtered and may not be
seen in the Events view

Click Start to re-upload all events from panel memory. Use the option only
after consulting Rosslare's Technical Support.

Note: A full upload can take up to 3 hours.
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Field Description

This option is only visible when the panel is configured with at least two
doors.

Select the checkboxes to apply the Door Interlock rule to the relevant doors.

A maximum of 10 readers can be defined with a door interlock rule when a
D-805 extension is connected to an AC-825IP panel’s expansion slot.

Note: When using a rule, be sure that it does not conflict with a existing
interlock group (Section Interlock Groups).

Door Interlock

Note: If you are configuring both antipassback (see the Antipassback
behavior table in this section above) and door interlock features, you must
configure the antipassback feature first.

Note: This function doesn’t work in AC-225, AC425 if reader was set in
Card+Card mode

This option allows you to reset the user counter to its starting value in the

event that a panel is disconnected and then reconnected again.
User Counter on re-enable the

panel This option is only visible when Deduct User Counter is selected on the

General tab of the Readers Properties window for one of the readers in the
panel (Section General Tab).

11. Click OK.
12. The window closes and the new panel appears in the Display Area.
6.4.1.2. Searching for Existing Access Control Panels
Alternatively, it is possible to search for panels over the access control network using the Find Panels

option. This is particularly useful during installations. AxTraxNG finds all connected panels in the network
and checks them. Panels can then be quickly activated and updated.
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To Search For Existing Panel On The Network:

1. Inthe Tree View, expand the AC Networks element and select a network.

2. Onthe toolbar, click the ' icon.

The Find Panels window opens.

i P

3. Click Find Panels to search for all connected panels in the network.

Once the detection process is complete (this may take a few minutes), the display shows all of the
detected panels and their corresponding information.

4. Select the panels that you wish to add and click Add Panels.
The selected panels then appear in the Tree View under current network.

Configure the panel settings as described in Section Adding an Access Control Panel Manually.

6.4.2. AC-825IP Panel

When you create a network for an AC-825IP panel (Section AC-825IP Panel), the AC-825IP panel is
automatically added to the network.

There can be only one AC-825IP panel in a network. However, you can add one expansion board to the AC-
825IP panel (Section AC-825IP) or up to 12 extensions using RS-485 (Appendix Configuring a Network).

6.4.2.1. Interlock Groups

For AC-825IP panels, interlock groups can be defined. A group of doors can be selected to be activated in
the interlock method, meaning only one door can be opened at a time.

A maximum of 5 doors can be defined per group.

A door can be selected to up to 5 different interlock groups.

A timer can be defined in case that interlock mode has been activated following door closing. All doors of
the group are disabled for that period of time.
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= When defining an interlock group, be sure that it does not conflict with an existing interlock
rule.

To Add An Interlock Group:

1. Inthe Tree view, expand an AC-825IP network.

2. Select Interlock Groups.

3. Onthe toolbar, click the + icon.

The Interlock Group window opens.

Interlock Group =]
Descnption Lock Time
InterlackGroup1 0000 +[v| (minsec)
Available Doors Selected Doors
T\Panel AC-8251P'Door 1 3

T\Panel AC-8251F'Door 10
T\Panel AC-8251P\Door 2

T\Panel AC-8251P'Door 3 «
T\Panel AC-8251P'Door 4
T\Panel AC-8251P'Door 5
T\Panel AC-825IP\Door 6
T\Panel AC-8251P\Door 7
T\Panel AC-8251P'Door 8
T\Panel AC-8251P'Door 3

*Mate: Disabled doors cannot be selected because they are being used in other context

4. Select and move the desired doors from Available Door to Selected Doors using the arrows.
5. Click OK.

The window closes and the new interlock group appears in the Display Area.
6.5. Adding an Expansion Board
6.5.1. AC-225x and AC-425x

For the AC-225x panels, you can add one MD-D02 or MD-1084 expansion board per access control panel.
For the AC-425x panels, you can add one MD-D04 or MD-1084 expansion board per access control panel.

To Add An Expansion Board:

1. Power down the panel.

2. Plugthe expansion board into the panel and repower the board supply.
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3. Inthe Tree View, expand the AC Networks element and select a network.

4. Onthetoolbar, click the Fl icon.

The Panel Properties window opens.

Panel Properties n
General  Antipassback | Opfions
Description Panel Address .
[3Panel 2 3 B ”M“”
] Enabled [] Hide events on this PC
Pane! Type Frmware Version (dadaten
1 Reader per Door ac2Z5Bv(5_00_01
Hardware Type Bootloader Version
AC-225 B MD-1084B bil_Rev B v04_00
Input Functions Output Functions
Input 1 Door 1 REX Output 1 Doar 1
Input 14 Desor 1 Monitar Ourput 1A General purpose
input 2 Dioor ? REX COutput 2 Dioor 2
Input 24 Desor 2 Monitar Output 2A General purpose
Input 5 Spare Input 5 Output 5 General purpose
Input & Spare Input & Output 6 General pupose
input 7 Spare Input 7 Output 7 General puposs
Input 8 Spare lnput B Output 8 General purpose
Input 9 Spare Input 5
<
Test New || 0K || Cancel
5. Click Test.
| Hardware 3\Panel 2 n;
Firmware Version: acZ258v05 00 1
| Bootloader Version: btl_Rev.B v04 00
Hardware Type: AC-Z25 B
Supervised Inputs: Yes
Board: MD-1084B
| Add Board Close
56
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6. Click Add Board.

After a few moments, the following confirmation appears.

AxTraxMG >

Board MD-1084E found. Do you want to insert the board?

ok || cancel

7. Click OK.

The window closes and the new panel appears in the Display Area.

[ =1 Toremove aboard from a panel, you must delete the panel from the database. ]

6.5.2. AC-825IP

For the AC-825IP panel, you can add an x-805 expansion board.

[ = Only one expansion board can be added per access control panel. ]

To Add An Expansion Board:

1. Power down the panel.
2. Plugthe expansion board into the panel and repower the board supply.

Once the AC-825IP panel is connected, you will see in the Hardware Version column in the Tree View
that the expansion board was installed.

Hardware Version
AC-825IP D-805
R-805

D-805

[ =!  Toremove aboard from a panel, you must delete the panel from the database. J

6.6. Configuring the Doors

Each panel controls one to eight doors. Each door can be configured individually.
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The Door window displays the following:
* The settings for unlocking and relocking

* Thetime available before the door relocks or records alarm events

To Edit The Door Properties:

1. Inthe Tree View, expand the AC Networks element.

N

. Expand a network and expand a panel.
3. SelectDoors.
The available doors are listed in the Display Area.

4. Select adoor inthe Display Area.

5. Onthetoolbar, click the IT:: icon.

The Door window opens.

Daor
Dietails
Description Automatic Relock
2 Panel 1Door On door monitor closed ™ |
REX Enabled

[] First Person Delay on Automatic Unlock
Marual Door Open Enabled
[ Door Qutput Polarity is Momally Closed

Timers

Cioaor Held Qpen 0:04 (2 (minsec)
Edended Door Open Time 0:08 (2 (minsec)
Door Held Open ] | 0:30 “| [min:sec)
Dioar Forced Open [ | 0:00 = {min:sec)

| oKk || Caneel |

6. Configure the door according to the fields described inthe following table:
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Field Description
Description Type a name for the door.
Automatic Relock Select the event that causes the door to relock automatically.

A Request-to-Exit unlocks the door for a user-defined duration. Select to
REX Enabled allow REX for this door. The location of the door REX input depends on
panel configurations; it can be seen in the Panel properties window.

Sets the door's behavior during an automatic unlock time zone. Select to
require that during the selected time zone, the door remains locked until the
first user opens it. The automatic unlock time zone is selected in Panel
Links by selecting the output corresponding to that door (see Section
Adding Panel Links).

First Person Delay on
Automatic Unlock

Select to ensure Fail Safe door opening if the Fail Safe door lock device
power fails. Once enabled, the door output relay is activated when the door
is closed and is deactivated when the door is open. In this configuration, the
Fail Safe lock device should be wired to the door relay N.O. (Normal Open)
and COM (Common) terminals.

Door Output Polarity is Normal
Closed

Select to allow operators to adjust the door manually (see Section Adding

Manual Door Open Enabled .
Panel Links).

Door open time Set the duration for which the door stays unlocked.

Set the duration for which the door stays unlocked for users with Extended

Extended door open time )
door open rights.

Set the duration for which the door can be held open without raising an
alarm event.

Select to use this timer. For the Server application, the Pop-up and Snapshot
section opens.

Door Held Open

= | If this feature is enabled, then the Activity start delay (Section
Adding a Biometric Terminal) feature for that door must be set
to 0.

Set the duration after which when the door is forced open, an event occurs.

Select to use this timer. For the Server application, the Pop-up and Snapshot
section opens.

Door Forced Open
= If this feature is enabled, then the Activity start delay (Section

Adding a Biometric Terminal) feature for that door must be set
to 0.

7. Configure the door as required.
8. Click OK.
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6.7. Configuring the Readers

A panel can be connected to two, four, or eight readers, when the MD-D02 or MD-04 extension boards are
connected.

The Reader Properties window has three tabs:
* General tab — Sets the reader general operation settings (General Tab)
* Options tab — Sets access options for the reader (Options Tab)

* Access event tab — Sets options for window pop-ups per event (Access Event)

To Configure A Reader:

1. Inthe Tree View, expand the AC Networks element.
2. Expand a network and expand a panel.

3. Select Readers.

The Available Readers Are Listed In The Display Area.

4. Select areader in the Display Area.

5. Onthetoolbar, click the Iﬂ icon.

The Reader Properties window opens to the General tab.
6. Configure the reader as needed using the tabs described in the subsections below.
7. Click OK.

6.7.1. General Tab

The General tab in the Reader window displays:
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* The settings for how the reader operates

* The type of reader being used

Reader [&]
General |Dﬁtior|s I Access Eventl
Dietails
Description Single Operation Mode
[1\Panel AC-825IP\Reader 1 | |card Only -
Direction: @ In [] User Dual Authentication
) Out Time Zone
Activation: Open 1\Panel AC-825IP\Door 1 |M1EVer
Number of Sessions Session Timeout
[ Deduct User Counter {sec)
Options
Primary Reader Format Keypad Type
['Megand 26 bits VI ’Inaciive VI
Secondary Reader Format Door Opening Requirement in Card+Card Mode
[None 'l [2 e vl
[ Check Facility Code Only [ Set as Muster
License Plate [ Biometrics
Conversion Table Biometric Temminals
None None

OK || Cancsl

Field Description
Details > Description Enter the name of the reader
Details > Direction Select whether the reader is allowing entry into the area or exit out of the area

Select to allow the reader to unlock the door.

. o If selected, the door output is active while a valid user is present.
Details > Activation

If cleared, access logged events are received online and appear in the Events
toolbar.

Select to record this entry against the user's entry allowance counter (see
Section General Tab)

Details > Deduct User Counter
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Field Description

Select how the reader operates:

® Inactive: The reader is not in use
® Card Only: The reader uses RFID cards only
® PIN Only: The reader uses PIN inputs only
Details > Single Operation Mode |® Card or PIN: The reader uses both cards and PIN codes

Desktop: The reader is inactive, but is being used to record new cards on the
computer

No Access: The reader does not grant access to any users
Card + Card: The reader grants access only when two separate users
present their cards

Select to activate the dual authentication mode, which enforces 2 credentials
per user per access

User Dual Authentication
=) A maximum of 10 readers in a network can be set with dual

authentication.

Select the time zone in which dual authentication is active

® Always (default)
User Dual Authentication > Time

Zone ® Never
® Any previously defined time zone(s) in the system

Select to define the number of sessions available
A session is the time during which 2 credentials per user for single access are

User Dual Authentication > presented.
Number of Sessions * 1 (default)

* 2 (for AC-825IP panels only)

User Dual Authentication > The length in seconds of each session
Session Timeout Range is 5 to 255, default is 10)

Options > Primary Reader

E ; Select the data transmission type for the primary reader hardware
orma

Select the data transmission type for the secondary reader hardware.

Options > Secondary Reader

Format = This field is used when 2 different types of cards are used.
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Field Description

Options > Keypad Type Select the data transmission type for the type of keypad hardware

. . Select 2 or 3 users needed to open the door in Card + Card mode.
Options > Door opening

requirement in Card + Card
mode

=) In AC-215A this function is disabled.

Select to allow access to any user assigned to a facility listed in the selected
list of facilities.

Options > Check Facility Code The list of facilities is defined on the Options tab.
Only

A This option is only available for certain formats.

License Plate Select to allow using a customized conversion table.

License Plate > Conversion .
Select the relevant conversion table.

Table

Options > Set as Muster Select to allow tracing the personnel that presented their credentials to it.
. . Select the check box to select from the drop down to map a reader to a

Biometrics

terminal (see Section From a Remote Network).

6.7.2. Options Tab

The Options tab in the Reader window displays:
* Timed antipassback settings for the reader

* Restricted site access settings
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Options | Access Event

Timed Antipassback
Automatic Antipassback

[Nevar v] @ Hard (alamm and access denied)
Time () Soft (zlam only)
0:01:00 i) (hh:mm:s0)

Facility Codes (0-255)

| oKk || Cancsl

1. Setthe properties according to the field descriptions in the following table:

Select whether to apply antipassback rules.
Automatic Antipassback
To set Time Zones, see Section Adding Time Zones.

When hard antipassback is selected, an event is generated and the door does

Hard

not open.
Soft When soft antipassback is selected, the door opens but an event is generated.
Time Set the number of minutes before a user can re-enter using this reader.

Click and type the Facility code (between 0-255). Up to four different Facility

Facility Codes
y codes can be entered.
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6.7.3. Access Event

The Access Event tab in the Reader window defines the alerts pop-up windows behavior on the local PC.

Reader Bl

Bocess Evert

Enable Pop-Up User Window by Events - PC SAM-PC1

Access Granted Close Window Options

Access Denied Manually

Pecess Recorded @ By Timer (min:sec)

Access Logged

[ ok || cancel

1. Setthe properties according to the field descriptions in the following table:

Access Granted Select to enable a pop-up window for Access Granted event type alerts.
Access Denied Select to enable a pop-up window for Access Denied event type alerts.
Access Recorded Select to enable a pop-up window for Access Recorded event type alerts.
Access Logged Select to enable a pop-up window for Access Logged event type alerts.

Once a pop-up is enabled, the close window options are available.
Select one of two options:

Close window Options Manually: The operator is required to manually close the pop-up window.

By timer: The pop-up window closes automatically based on the predefined
timer.

6.8. Adding a Biometric Terminal

You can add a biometric terminal to a network using the Biometrics element.

A biometric terminal can be used to read and transmit credentials or enroll new credentials (fingerprint and
cards).

The terminals support both TCP/IP and Wiegand protocols.

Adding a biometric terminal can be done both on a local network and from a remote network.
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6.8.1. On a Local Network

To Add A Biometric Terminal On A Local Network:

1.

o o > w

On the toolbar, click the + icon.

The Terminal Configuration window opens.

In the Tree View, expand the Biometrics element and select Terminals.

[#=] Terminal Configuration

Wiegand Format

— General
Description Terminal 1
Enabled
Series Number Bio 8000 R
Model Number AY-BE5x0 =

Wiegand 26 Bits

Fingerprint Precision | Medium -
— Info
Firmware Version 56.03.A
Serial Mumber 9190258
AC Reader 2\Panel 1\Reader 2
— TCR/IP Network
MAC Address 00:22:CA:8%:30:0C
|P Address 192.1688.10.158
— Terminal Capacity
Port 5010 : _ -
Configuration | Usad n
| OK | | Cancel

In Description, enter a name for the new terminal.
Select Enabled to enable the terminal.

In Model Number, select the reader model.

Inthe TCP/IP Network area, enter the MAC address, IP address, and the port.
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s '
=1 For models AY-B9250BT and AY-B9350, an additional Enable camera snapshot check box
appears. If selected, the terminal takes a snapshot of the terminal view.
N Y,
e A
= For Bio9000 series there is an option of Live Fingerprint detection.
Once enable this option, expect to get longer time for recognition and lower recognition
rate.
_ J
7. Click OK.

The window closes and the new terminal appears in the Display Area.

If you do not know the connection settings click Configuration to locate the hardware on the local
network. Refer to Appendix Configuring a Biometric Terminal for how to search for a biometric terminal

and configure it.

6.8.2. From a Remote Network

To add a biometric terminal from remote network, you must first receive an exported file from the remote
network that contains all the terminal’s configuration settings. Once you receive this file, you can then add
the biometric terminal by importing this file.

6.8.2.1. Exporting a Terminal File
To export a terminal file:

1. Inthe Tree View, expand the Biometrics element and select Terminals.

2. Onthe toolbar, click the + icon.

3. The Terminal Configuration window opens.
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[#=] Terminal Configuration >
— General
Description Terminal 1
Enabled
Series Number Bio 8000 -
Model Mumber AY-BE5x0 =
Wiegand Format Wiegand 26 Bits -
Fingerprint Precision | Medium -
~ Infa
Firmware Version
Serial Number
AC Reader
— TCR/IP Metwork
MAC Address [
" Address e — Terminal Capacity
Port o0 - Tota T00C

| Configuration

Cancel

4. Click Configuration.
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5. The TCP/IP Configuration window opens and automatically searches for any terminals connected to
the network.

[¥=] TCP/IP Configuration *
= = i~ Configuration
Serial Number | MAC Address IP Address Model Number  Status Configuration
00:02:65:18:8C62  192.168.10.55  AY-B9350 Available Not Configured P Addrass
00:02:65:18:98:90 |192.168.10.21 [AY-B91x0 Available Mot Configured 192.168.10.55
18460001 00:22:CABSAC02 [192.168.10.86 | AV-BE5x0 Available Not Configured
19150233 00:22:CA:89:0B8:7A  |192,168.10.165 | AY-BE5x0 Available Mot Configured Port
19190107 00:22:CA:89:2F:75  |10.10.3.241 AY-B85x0 Available Not Configured 7332
18270182 00:22:CA:BAFB:44 | 192.168.10.87 | AY-BA&x0 Available Not Configured
Subnet Address
255.255.255.0
Gateway Address
192,168,101
Server IP Address
| Manual |
| Apply |
‘ Export | Terminals Count lIl All I ‘ Search | Cancel |

6. Click Export.
The Save as window appears.

7. Save the file (xxx.axbio) on your PC where it can be easily accessed.

1 The Export function adds “axbio” to the end of file name of the exported file. The Import
function executes only with a file that contains this string at the end of the file name.

6.8.2.2. Importing a Terminal File
To import a terminal file:

1. Inthe Tree View, expand the Biometrics element and select Terminals.

-3
2. Onthe toolbar, click the icon.
The Import Terminal window opens.
3. Browse to the previously exported xxx.axbio file and double-click it.

The window closes and the terminal appears in the Display Area.

6.8.3. Mapping a Biometric Terminal to a Reader

Once you have added a biometric terminal to the system, you must map it to a specific reader in order for
the system to recognize the terminal.

To Map A Biometric Terminal:

1. Inthe Tree View, expand the AC Networks element.

2. Expand a network and expand a panel.
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3. SelectReaders.
The available readers are listed in the Display Area.

4. Selectareader in the Display Area.

5. Onthe toolbar, click the Fl icon.
The Reader Properties window opens to the General tab.

6. Select the Biometric check box and select the relevant terminal from the drop down.

Biometrics
Biometric Terminals

ene -

Biometrics

Biometric Temminals

e ——

— Teminal 1 —

7. Click OKto accept the changes.

When you select the Terminal element, you can now see to which reader the terminal is mapped in the
Display Area.

AC Reader
T\Panel AC-B25IP\Reader 1

6.8.4. Terminal Firmware Update

To Update The Firmware:

=1 This function is available only for the 9000 Biometric series

1. Inthe tree view expand the Biometrics > Terminals.

2. Select aterminal.
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Wy,
3. Onthe toolbar click # icon.

The following Terminal Firmware Update screen will appear

& Terminal Firmware Update

X
Model Number AY_B91x0
Firmware Files ‘ AY-BOTXO0_FW v2_003_D050.bin ‘- ‘
E. Description ‘ Address Firmware Version | Progress ‘
b AY-B91x0 192.168.10.156  2003-59 -

Close

4. Check the terminal(s) from the list
5. Click Apply.

6. Waittill the process will finish and click Close.

6.9. Configuring the Inputs

Each panel has four inputs. Using the MD-1084 expansion board adds an additional eight inputs (a total of
12 inputs). Using the MD-D02 or MD-D04 expansion board adds four inputs (a total of 8 inputs). Some
inputs are dedicated and have default functionality and some are for general purpose.

The table window displays the settings for each input. Input type is programmed individually, regardless of
whether it is a dedicated input or for general purpose use.

To Configure An Input:

1. Inthe Tree View, expand the AC Networks element.

2. Expand a network and expand a panel.
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3. Select Inputs.

The available inputs are listed in the Display Area.

Location Description Type Activity Start Delay
» p Normally Open hd

Input 1A 1\Panel 1\Door Monitor MNormally Close * | 00:00

Input 2 1\Panel 1\5pare Input 2 MNermally Close * | 00:00

Input 24 1\Panel 1\5pare Input 24 MNormally Open - | 00:00

4. Setthe properties according to the field descriptions in the following table:

Field Description

Location A display field showing the input name
Description Type a name for the input.

Select the type of input to be monitored.

* Normally Open/Close: An input either in an open or closed state

* Normally Open/Close 1 Resistor: An input in an open, closed, or trouble
Type state. This option is only available for supervised inputs.

Normally Open/Close 2 Resistors: An input in an open, closed, or trouble
state, with additional checks for short-circuit and open-circuit tampering.
This option is only available for supervised inputs.

For more information, refer to the access control panel’s hardware manual.

Activity Start Delay

Set the delay time before this input becomes active. Note that on normally
open input, the delay starts once the input contact is closed. On normally
closed input, the delay starts once the input contact opens.

Function

properties.

5. Select aninput and configure it as required.

6.10. Adding Panel Links

Panel links are rules defining how the system should behave when events occur in the access control panel.

Select the door function: Door Monitor or Door REX

This column is visible only if the REX enable check box is selected in Door

Numerous events and links can be defined. It is the operators’ responsibility to avoid conflicting or non-
logical definitions. Not all events that appear in the Link window are enabled in the panel; this too is the
operator’s responsibility to verify. Link condition operations should be checked after making any changes

in the links definitions.

The Linkwindow displays the following:
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* Aneventon a panel and the panel component to which the link response applies

* Therequired input or output response

® Any alarm message to display on the current AxTraxNG Client computer

To Create A Panel Link:

1. Inthe Tree View, expand the AC Networks element.
2. Expand a network and expand a panel.

3. Select AC Links.

4. Onthetoolbar, click the + icon.
The AC Link window opens.

AC Link =]
Source Type Destination Panel
[lnput '] [Nnn& v]
Source Destination Type
|Input 1 - 2\Panel 1\Door REX | |None -|
Event Destination
[Corrtac:t Closed "] ’None v]
Event Description Operation
Contact Closed | None -|
Enabled Time {m:ss)
[7] Generate alam
Time Zone
’N&v&r v]
| Alarm Handle |
| MNew |[ ok || Cancel |

5. Configure the link rule as required according to the field descriptions in the following table:

Field Description

Select the panel component type, input, output, reader, and so on which is

Source Type
yp the event source

Select the specific panel component that raises the event based on the
source type selected.

Source Up to 8 links can be created for each source type in the AC-225, AC-425, and
AC-825IP panels. Up to 2 links can be created for each source type in an AC-
215 panel.

Event Select the event type for the panel component
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Event Description Type the link or event description
Enabled Select to enable the link rule
Generate alarm Select to generate an alarm event in addition to the link rule activity

Select to enable global triggering of an output group
Open all Outputs of selected

This check box appears when Destination Type is Output Group.
Output group
From the network, select the board to be activated by the link rule trigger
event

Destination Panel

Select the panel component type, which is to be activated by the link rule

Destination Type )
trigger event

Select the specific panel component, which is to be activated by the link rule

Destination .

trigger event
Operation Select the operation performed by the destination panel component
Time Define a duration time frame for the operation. This box is only available

when a time-bound operation is selected

Select the delay time (in seconds) for the operation.
Delay for the Target Operation

This appears when Destination Type is specified.

Time Zone Select the time zone for which the link rule applies
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Field Description

The Alarm Handler function is only enabled when Generate Alarm is
selected.

The Alarm Handler configuration window contains the following fields:

Alarm Message: Type a personalized message to be displayed on the
screen as an alarm message when the selected event occurs

Pop up Enabled: Select to enable an alarm pop-up message

Select Color button: A color selection window opens allowing a color
selection for the alarm message

Browse... button: Find and upload an audio wav file to be sounded when
the selected event occurs

Sound Now button: After uploading the audio file click to button to hear

the audio file
Alarm Handler
Local Sound Enabled: Select to enable sound for the alarm

Fire Input Alarm: Select to open all outputs, usually relevant for fire
alarms

In addition, when a camera is linked to a panel, the following fields appear
in the window:

® Camera: List of available cameras
Options: Which alarm is activated

Opus Enabled: Activates a pop-up to appear on the user’s screen when
alarm is triggered

Close window options: Can select By timer and specify the time, or
Manually
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6. [Optional] Set a general alarm:
a. Select Generate Alarm to activate the Alarm Handler button.
b. Click Alarm Handler.

The Alarm Handler window opens.

amtoeder_pCSAMPCL &

Message Popup Cameras options

Alarm Message Camera

| ’Nu:e v]
Ciptions
| Pop up Live video window - |

[] Popup Enabled

Close window options

Popup Enabled Manualty

Use highlight alarm evert

Sound
Select Wave Audio file

] Local Sound Enabled | Sound MNow | [ Browse... l

ok J[ Comesl |

c. Configure the alarm handler as required, according to the field descriptions in the link rule table in
this section.

d. Click OKto return to the Link window.
7. Click OK.

6.10.1. Creating a Fire Alarm Input
You can configure the panel properties to generate a fire alarm warning.
To Create A Fire Alarm Input:

1. Inthe Tree View, expand the AC Networks element.
2. Expand a network and expand a panel.

3. Select AC Links.

4. Onthetoolbar, click the + icon.

The Link window opens.
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5. Configure the link as follows:
a. InSource Type, select Input.

b. InSource, select either a Door Monitor or a Spare input.

Input 1 - 1\Panel 1*Doaor REX

Input 1A - 1%Panel 1"\Door Monitor
Input 2 - 1\Panel 1\Spare Input 2 2
Input 2A - 1%Panel 1"5pare Input 2A

c. InDestination Panel, select the relevant panel.

o

In Destination Type, select Output Group.

=1 Output Group only appears in Destination Type if an output group is defined for that
panel (Section Adding Output Groups).

e. InOperation, select Timer Active.
f. Select Generate Alarm.
6. Click Alarm Handler.

The Alarm handler window opens.

Alarm Handler— PC SAM-PC1 a

Message Popup Cameras options

Alarm Message Camera

| [ Maone v]
Options
| Pop up Live video window - |

[] Popup Enabled

Close window options
@ By Timer {min:zec)

Popup Enabled Manualty

|Uze highlight alam event Fire Input Alam

Open all Outputs of selected Output group

Sound
Select Wave Audio file

] Local Sound Enabled | Sound Mow | [ Browse... ]

ok J[ Caned |
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7. Configure the alarm handler as required, according to the field descriptions in the table in Section
Adding Panel Links.

8. Select Open all Outputs of selected Output group.

9. Click OKto return to the Link window.

10. Click OK.

6.10.2. Global Triggering of Output Groups

Global triggering is used for cross panel activations. For example, in case of a fire alarm, all doors in the
system are opened from a single input.

To Create Global Triggering Of Output Groups:

1. Inthe Tree View, expand the AC Networks element.
2. Expand a network and expand a panel.

3. Select AC Links.

4. Onthetoolbar, click the + icon.

The Link window opens.
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5. Configure the link as follows:
a. InSource Type, select Input.

b. In Source, select either a Door Monitor or a Spare input.

Input 1 - 1%Panel 1.Door BREX

Input 14 - 1%Panel 1.Doar Manitor
Input 2 - 1\Panel 1\Spare Input 2 e
Input 24 - 1%Panel 1%.5pare Input 24

c. InDestination Panel, select the relevant panel.
d. InDestination Type, select Output Group.

e. Select Open all outputs of selected output group, which is now visible.
T

Link Properties =
Source Type Destination Panel
[ inpu | [1\Panel 1 7]
Source Destination Type
[ Input 14 - T\Panel 1\Door Monitor | |output Group -
Event Destination
| Contact Closed | |Output Group 1 test -
Event Description Operation
Contact Closed [Fol]ow v]
Enabled Time {m:ss]
Generate alam
Open all outputs of selected output group Time Zone
[N&ver v]
| Alam Handler... |
| New || ok || cancel |

6.11. Adding Video Integration

See Chapter Video Integration.

6.12. Adding Groups

You can create access groups and areas, as well as input and output groups to be used by the system to
create automated rules.
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6.12.1. Adding Access Groups

An access group includes a list of door readers and the time zones during which each of those door
readers are available for access. Every user is assigned to an access group.

To Add An Access Group:

1. Inthe Tree View, expand the Groups element.

2. Select Access Groups.

3. Onthe toolbar, click the + icon.

The Add Access Group window opens.

ok J[ Concd |

4. Inthe Description field, enter a name for the access group and click OK.

The new access group appears in the View Tree.

5. Select the access group from the View Tree and click the El icon.

The Access Group Properties window opens.
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Access Group — Details [=

Name

Access Group 2 [+ Expand Al & Fiter

@-[C] Master

Time Zone
Set Time Zone

(o 2

6. From the Time Zone drop down, select a time.
7. Expand the list and select the desired readers.
8. Click OK.

The window closes and the new access group appears in the Display Area.

6.12.2. Adding Input Groups

Input groups are a collection of inputs from one or more panels that can be used in panel links to perform
advanced operations.

To Create An Input Group:
1. Inthe Tree View, expand the Groups element.

2. Select Inputs Groups.

3. Onthe toolbar, click the + icon.

The Input Group window opens.
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Description |[falRcen=n |

-8 Network 3 Select Al

%} Metwork 825 extension

-3 Network 825 panel

4. Inthe Description field, enter a name for the input group.
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5. Expand a network to see its panels.

Elh- Metwork 3

=- ] 3\Panel 1

. 71/ 3\Panel 1\Door REX
;:I JPanel 1"Door Monitor
-[]/7] 3\Panel 1\Spare Input 2

- 04 3vPanel 1\Spare Input 24
= B 3\Panel 2

-[7]-7] 3\Panel 2:Door REX
/:I FPanel 2Door Manitar
/.:I FPanel 25pare Input 2
/‘:] IPanel 2\Spare Input 24
]%} Metworke 325 extension

-1 Network 825 panel

=1

=l

6. Select the check boxes of all relevant inputs. You can also use Select All.
7. Click OK.

The window closes and the new input group appears in the Display Area.

6.12.3. Adding Output Groups

Output groups are a collection of outputs from panel that can be used in panel links to perform advanced
operations, such as elevator control.

To Add An Output Group:

1. Inthe Tree View pane, expand the Groups element.

2. Select Outputs Groups.

3. Onthe toolbar, click the + icon.

The Output Group window opens.
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Q} Metwork 3 Select Al

-@} Metwork 825 extension

e84 Network 825 panel

New |[ ok || Cancel

4. Inthe Description field, enter a name for the input group.
5. Expand a network to see its panels.

=-8§ Network 3
EI i 3\Panel 1
- {5 3Panel 1\Doar
ﬂ:/ IPanel \Output 1A
t‘/ IPanel T\Dutput 2
05 3WPanel 1\Output 24
EI 0| 3WPanel 2

.:‘/ IPanel 2Door
~{C% 3\Panel 2\0utput 1A
FPanel 20utput 2
IPanel 20utput 24
-2 Network 825 extension
-1 Network 825 panel

6. Select the check boxes of all relevant outputs. You can also use Select All.
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7. Click OK.

The window closes and the new output group appears in the Display Area.

6.12.4. Defining Card + Card Groups

Card + Card mode is a secure mode that requires two card holders (users) to grant access to a particular
reader.

[ = This feature is not available for AC-215 access control panels. ]

6.12.4.1. Adding a Card + Card Group

First, you must add a Card + Card group.

To add a Card + Card group:

1. Inthe Tree View pane, expand the Groups element.

2. Select Card + Card Groups.

3. Onthe toolbar, click the + icon.

The Card + Card Group window opens.

4. Inthe Description field, enter a name for the input group.
5. Click OK.
The window closes and the new Card + Card group appears in the Display Area.

6.12.4.2. Adding Users to a Card + Card Group

Once a Card + Card group is created, you must add users to it.

To add users to a Card + Card group:

1. Inthe Tree View, expand the Departments/Users element and select a department that contains the
users you wish to add to the Card + Card group.

2. Select a user in the Display Area.

3. Onthe toolbar, click the I?l icon.
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5.
6.

On the General tab of the User Properties window (see Section General Tab), select the Card + Card
group from the Card + Card Group drop down.

Click OK.

Repeat this process for each user you wish to add to a particular Card + Card group.

6.12.4.3. Adding Users to a Card + Card Group

Once a Card + Card group is created, you must add users to it.

To add users to a Card + Card group:

1.

5.
6.

In the Tree View, expand the Departments/Users element and select a department that contains the
users you wish to add to the Card + Card group.

Select a user in the Display Area.

On the toolbar, click the Fl icon.

On the General tab of the User Properties window (see Section General Tab), select the Card + Card
group from the Card + Card Group drop down.

Click OK.

Repeat this process for each user you wish to add to a particular Card + Card group.

6.13. Adding Access Areas

A large site can be divided into several smaller, more manageable access areas. Reports can be produced
individually for each area. In addition, global Antipassback rules can be applied for each access area. When
global Antipassback rules are in effect, users cannot re-enter an access area until they have left it.

Use the Access Area window to add entry and exit door readers to and from an area within the facility.

To Add An Access Area:

1.
2.

In the Tree View, expand the Groups element.

Expand the Access Areas element and click Global.
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3. Onthe toolbar, click the + icon.

The Add Access Area window opens.

Available Readers to Enter: Selected Readers To Enter:
.
L€ ]
e e
5 5
Available Readers to Bxit: Selected Readers To Bt:
N
L €
e e
5 5
oK || Cancel
4. Inthe Description field, enter a name for the access area.
5. Select and move the desired readers from Available Readers to Enter to Selected Readers to Enter
using the arrows.
6. Select and move the desired readers from Available Readers to Exit to Selected Readers to Exit
using the arrows.
7. Click OK.

The window closes and the new access areas appear in the Display Area.

6.14. Adding Departments, Users, and Visitors

Every user is associated with a department. For each user, AxTraxNG stores contact details, associated
card details, and access rights.
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6.14.1. Adding Departments
To Add A Department:

1. Inthe Tree View, expand the Users element and click the Departments/Users element.

2. Onthe toolbar, click the + icon.

The Add Department window appears.

m

Description
Department 2

ok J[ Concd |

3. Inthe Description field, enter a name for the department and click OK.

The window closes and the new department appears in the Display Area.

6.14.2. Adding an Individual User

Adding users to a department is done by using the User Properties window.

The User Properties window contains three main tabs:
* General tab — Displays identification and control information (Section General Tab)
* Codes tab - Displays card information associated with the user (Section Credentials Tab)

* Details tab — Records user contact details (Section Details Tab)

In addition, there are two content-oriented windows:
° User Fields — Stores user-defined data (Section User Fields Tab)

® Visitor Tab — Appears when the user is defined as a visitor (Section Auto Opening for Output Groups)

To Add An Individual User:

1. Inthe Tree View, expand the Users element.

2. Expand the Departments/Users element and select a department for the new user.

3. Onthe toolbar, click the + icon.

The User Properties window opens.

AxTraxNG™ V27.7.x.x User Guide 88



ROSSLNR=

6. Setting Up a Site

4. Enter the user details as needed using the tabs described in the subsections below.

5. Inaddition, you can click the i next to Access Group to open the Access Group — Details window,

where you can select to which access panels that access group is granted permission (see Section
Adding Access Groups).

6. Click OK.

The window closes and the new user appears in the Display Area.

6.14.2.1. General Tab

The General tab displays:

* User identification information

* User validity settings

* Access rights for the user

Figure 3: Departments/Users > User Properties > General Tab

User Properties
General Q'edemalsl Details
Photo
First Name Middle Name
john
Last Name User Number (1to 2000000000)
amitn [ =
Department Access Group
[Genewl v]  [Unauthorized -] [
Car Parking Group Card + Card Group
[Nene - [None -
Identfication
Valid Date
From Until
[T] 11/14/2018 [Ehg 11/14/2018
00:00 2 2359 |5
[ Coler... ] [ Location... ] Counter Email Notifications
Rights Enable Courtter Valus § Enable
Set New Counter 1 (1to 1000)
Antipassback Immunity
[Neug v] Links User Dual Authentication Overide on Reader
Access Granted Command -
Extended Door Open Time Access Denisd Command |FC-F:e Time Zone |
Never hd
Interdock Immurity Handicapped
Time Zone Immunity
User Selected Output Group | Never . |
= g

The General tab fields are described in the following table:

Field | Description

Click to add a photo of the user, or to remove an existing photo.
The selected photo aspect ratio should be 1.25 H x 1.00 L; otherwise, the
photo may be distorted.

Photo > Add

Be sure that the photo is rotated properly before adding it.
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First Name Type the user's first name.

Middle Name Type the user's middle name.

Last Name Type the user's last name.

User Number Type a unique user number to identify the user.
Department Select the user's associated department.

Select the user's access group.
Default: Unauthorized
Access Group
Click i to add the user to a custom access group within all available
readers and mapped terminals.

Car Parking Group Select to add a user to a defined Car Parking group.
Card + Card Group Select to add a user to a defined Car + Card group.
Identification Add text that identifies the user

Click to select which color to use to highlight this user when the user
Color generates access events.

User highlighting must be activated in Tools > Options > General tab.
Location Click to display a log of doors accessed by this user.
Valid Date > From Select the date/time from when the user's access rights begin.
Select the date/time on which the user's access rights end.

This field is only available when the check box is selected.

Valid Date > Until N For AC-215 panels, only the date is recognized; the time entered

is not recognized. Also, the Until date is not part of the valid
range.

Select to set an access rights countdown counter for this user (see Appendix
Counter > Enable Configuring User Counters).

When the counter reaches zero, the user's access rights end.

Select to set a new countdown counter value for this user (see Appendix

Counter > Set new counter .
Configuring User Counters).

Select a new countdown counter value for this user.
Counter > Counter Value
This field is only enabled when the Set new counter check box is selected.

Select to enable email notifications to be sent to the user’'s email, which is

Email Notifications > Enable
defined in the Details tab (see Section Details Tab)
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Field Description

Rights > Antipassback
Immunity

Rights > Extended Door Open
Time

Rights > Interlock Immunity

Rights > Auto Open

Links > Access Granted
Command

Links > Access Denied
Command

Links > Handicapped

Links > User Selected Output
Group

User Dual Authentication
Override on Reader

Select to override any Antipassback restrictions for this user.

Never

Always

User-defined time zone

= For an AC-215 access control panels, only Always will work.

Select to entitle this user to an extended unlocked door duration. The extended
duration is set for each door (see Section AC-825IP).

Allows the user to open doors within the relevant access group regardless of
the interlock status

A This feature works only for AC-825IP.

When defining user properties, you can define certain output groups to be
active automatically (see Section Auto Opening for Output Groups).

Select to activate a link rule initiated by access granted commands for this
user (see Section Adding Panel Links).

Select to activate a link rule initiated by access denied commands for this user
(see Section Adding Panel Links).

Select to activate a dedicated output a short time after the door is unlocked
(see Section Adding Panel Links).

Select an output group for this user. The outputs are triggered every time the
user accesses a door, as specified in the Links window (see Section Adding
Panel Links).

Select to override the dual authentication defined by the system (see Section
General Tab).

Force Time Zone: The user must present two credentials, even though the
reader does not require it.

= For this feature to be active, the Dual Authentication Mode check
box in the Reader window (Section General Tab) must be
selected.

Time Zone Immunity: User is granted access per one credential and not per
two credentials, even though the reader might be in “User Dual
Authentication” mode.
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6.14.2.2. Credentials Tab

Use the Credentials tab to associate up to 16 cards with each user, as well as to assign a user’s PIN
codes.

User Properties n
General Credertials Details
Details

Protocol Issue Number Site Code Facility Code Card ID Credential Type Details Status
Wiegand 26 bits ~ 2 am Fingerprint ~ |R2 BioBD00D |Active |v
Wiegand 26 bits ~ 11 2222 BLE ~ Active ~
Wiegand 26 bits ~ 123 AEEE Card ~ Active ~
Wiegand 26 bits ~ 11 4444 UHF ~ Active ~
Wiegand 26 bits ~ 122 h5bh NFC ~ Active ~
Wiegand 64 Bits ~ 32247214414883717... | License Plate ~ | AB-123.CD Active v

b Wiegand 26 bits ~ Card ~ Active |~

‘ Enroll from Fingerprint Terminal | Enroll from Face Teminal ‘ | Enroll from Desktop Reader | | Enroll from License Plate | ‘ Add from List |
PIN Code Duress PIN Code
Mumber of Digits (4 to 8) Code Mumber of Digits (4 to 8) Code
" — T —
[ New [ ok || cCancel |

The Credentials tab fields are described in the following table:

Field Description

Displays the various properties of the credential added to the system for the
user

Details
= | The Issue Number and Site Code fields are only available if the

Protocol selected is “Rosslare 38-Bit (Rosslare Proprietary)”.

Details > Enroll from Fingerprint

Reader Click to enroll a user’s fingerprint (see Appendix Enrolling a User’s Fingerprint).
Details > Enroll License Plate Click to enroll a license plate (see Appendix Enrolling a License Plate).

Details > Enroll Face from . . . .
Click to enroll a face from a terminal (see Enrolling a Face from a Terminal).

Terminal
Details > Enroll from Desktop Click to enroll credentials using a desktop reader (see Appendix Enrolling a
Reader License Plate)
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Field Description

Click to associate a user to a card or multiple cards (see Section Associating a
User to a Card).

A Before you can associate a user to a card, you must be sure that
the card has been added to the system (see Section Auto
Opening for Output Groups).

Details > Add from List

All cards within the user's specified Facility code are listed

Define PIN and Duress PIN code options:

* Number of digits: Select the length of the PIN for this user
PIN/Duress PIN Code
/bu ® Code: The 4-to 8-digit PIN and/or Duress PIN code

* Random PIN Code: Click to automatically generate a random PIN

6.14.2.3. Details Tab

The Details tab contains detailed contact and identification details about the user.

User Properties E
General | Credertials | Details

Telephone Home Telephone

Mobile Car Registration

Fax Title

Email Employment Date
117142018 @~

Address Notes

New [ ok ][ Canedl

The Details tab fields are described in the following table:

Field | Description

Telephone Type an office telephone number for the user.
Mobile Type a cell phone number for the user.
Fax Type a fax number for the user.
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Field Description

Email Type an email address for the user (up to 100 characters)
Address Type a postal address for the user.

Home telephone Type a home telephone number for the user.

Car registration Type the user's license plate number.

Title Type the user's title (e.g. "Mr.").

Employment Date Enter the date that the user joined the firm.

Notes Type any additional information.

Details Click to open the user's additional details folder.

6.14.2.4. User Fields Tab

The User Fields tab can be used to store any information required by the system operator.

User fields are defined on the User Custom Fields tab under Tools > Options (see Section User Custom
Fields).
6.14.3. Auto Opening for Output Groups

When defining user properties (see Section Adding an Individual User), you can define certain output
groups to be active automatically.

= Output that needs to active this function must be always in Active state in the “Event Filter”
(Panel properties > Options).

To Define Auto Open For Output Groups:

1. Inthe Tree View, expand the Users element.

2. Expand the Departments/Users element and select a department for the new user.

3. Onthetoolbar, click the IF' icon for a user.

The User Properties window opens.
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User Properties
{ General | Credentials | Details |
Fhoto First Name Middle Name
john
Last Name |U5er Number (1 to 2000000000) |
smith 1 v
Department Access Group
| General -] [Unauthorized =) ()
Car Parking Group Card + Card Group
[None - [none -
Identification
Va;ir:rr[‘lata Ul
111472018 (kg 11/14/2018
Add
ot &
[ Color. l [ Location l Counter Email Notifications
Enable Courter Valug =
Fitis Set New Courter 1 (1o 1000 ol
Antipassback Immunity
[Neve( v] Links User Dual Authertication Ovemide on Reader
Access Granted Command N
Extended Door Open Time Access Denied Command ‘F;;;T\me Zong 'l
Interlock Immurity Handicapped
Time Zone Immunity
User Selected Output Group N .
e 7 || te= '
(o few [ ok [ coce
4. Inthe Rights section, click Auto Open.
Rights
Antipassback Immunity
’ Mewver -
Extended Dioor Open Time
HLX Am
Intedock Immunity
[ Auto Cpen... ]
The Auto Open window opens.
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Output Group

1'Panel 1%Reader 1
1Panel 1"Reader 2
1"Panel 1"Reader 3
1"Panel 1"Reader 4

pu

BN

Time Zone
[ v] | Aways v
Time
0004 Ll
Readers

=
iy

I

oK

| [ Cancel

5. For each output group selected in the Output Group drop down:

a. From the Time Zone drop down, select a time zone.

b. From the Time box, select a duration time of the activation.

c. Select and move the desired readers using the arrows.

6. Click OK.

6.14.4. Adding a Batch of Users and Cards

One can also add a batch of users and cards at one time and define the following:

* The type of reader needed to read the card

* The number of cards to create

* Whether or not a user should be created for each new card
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To Add Users And Cards:

1. Inthe Tree View, select the Users element.

2. Onthe toolbar, click the % icon.

The Add Users and Cards window opens.

Add Users and Cards =
Please note that the mass addition of users takes time, depending on the amount of users, panels, and so on. During this time, the client will
not respond. Please wait patiently until the process finishes.
Selection Type Sequertial Cards
[Acd Users and Cards g | [Federe
[Wiegand 26 bits - ]
Quaritty Start from (1 To 65535 Facilty Code (0 To 255
f = 1 B o [
Sequential Users
General [C] PINCode Links
Hlen e @ Started from 1000 = [C] Access Granted Command
(Geners 7] - : [ Access Deried Command
o cess Leni mman
Access Group Random Digits
[m Group 2 v] E] || Handicapped
) Valid Date User Selected Output Group
Rights From
Artipassback Immunity & VAT @~ 00:00 ey [None T
Mewver -
[ ] [ Uil Courter
[ Extended Door Open Time (& 32007 | [2358 < [0 Enabe {Tto 1000)
[T] HLX Am
[ ok | [ caneat |

w

Configure the card properties as required according to the field descriptions in the following table:

Selection Type Select what will be added: Users and cards, Users only, or Cards only
Quantity Type or select the number of cards/users to add

Define the card properties:

Reader Type: Select the type of reader appropriate for the new cards

being added

Sequential Cards ¢ Start from: Type the number of the first card in the set

Facility code: Type the site code for these cards. This field is not
available for all reader types

Define the users general properties:

Department: Associate to the new user(s) created to a department

Sequential Users > General Access Group: Associate to the new user(s) created to an Access group

Click i to add the user to a custom access group within all available
readers.

AxTraxNG™ V27.7.x.x User Guide 97



ROSSLNR= 6. Setting Up a Site

Field Description

Define the users right properties:

Antipassback Immunity: Select how to override any antipassback
Sequential Users > Rights restrictions: Never, Always, according to time zone

Extended Door Open Time: Select to activate the extended door option
defined for each door

Select to define automatic pin codes, select between:

Start from: Sequential pin code starting from a predefined number based
Sequential Users > PIN Code on a defined number of digits

Random: Random pin codes where the only definition is the number of
PIN code digits
Define the access right validity:

® From: Define the date and time to begin allowing access
Sequential Users > Valid date

® Until: Select to define an end date for the access right validity, then
define the date and time

Select to define associated link commands:

® Access Granted check box: Activate a user-defined set of inputs or
outputs for access granted events

® Access Denied check box: Activate a user-defined set of inputs or
outputs for access denied events

Sequential Users > Links * Handicapped check box: Activate a dedicated output a short time after
the door is unlocked. The outputs are set in the Links window.

User selected Output group: Select an output group for this user. The
outputs are triggered every time the user accesses a door.

The operations, inputs, and outputs are defined in the Links window (see
Section Adding Panel Links).

Select Enable to use the counter option then type or select the counter

Sequential Users > Counter
q number to be used for the first user

4. Click OKto close the window.

The process may take a few minutes after which a dialog reports that the operation has been
completed.

6.14.5. Setting Card Automation

You can program the system to automatically keep track of any user card that has expired because of non-
use over specified period of time. Once detected, this card can either be deleted automatically or you can
be notified of it.
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To Set Card Automation:

1. Inthe Tree View, expand the Users element.

2. Expand the Cards element and click Card Automation.

3. Onthe toolbar, click the + icon.

The Card automation window opens.

Card Automation =]

Automation Type
Aslc before card deletion hd

Automation Description
Azl before card deletion

Period

60 ) (days)

| ok || cancel |

4. From the Automation Type drop down, select the action to be taken when a card has not been used in a
certain period of time.

* Delete card automatically
* Ask before card deletion

* Notify by email

% For this option, you must supply an email address and you can add an optional

signature.

* Reportin System Event Log only

5. From the Period box, select the time period.
6. Click OK.

6.14.6. Adding Visitors

In addition to regular users, you can add visitors to the system, which includes their contact details,
associated card details, and access rights.
The Visitor's options tab contains the following fields:

Visitor Identification Type a unique visitor identification

Visit Date/Time Select and specify the date and time for the visit
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Field Description

Automatic disable on exit

Hosted

To Create Visitors:

Define automatic disable access right options:

Access Area: Select the Access Area to disable access to

Inactive card: The designated card automatically becomes inactive upon

exit

Unauthorized user: the designated access group changes to Unauthorized

upon exit

Define the details for the hosting party:

Department: Select the Department
User: Select the hosting User

Comment: Type any additional information

1. Inthe Tree View, expand the Users element and click Visitors.

2. Onthe toolbar, click the + icon.

The same User Properties window as before opens; however, now the Visitor’'s Options tab is

available.

User Properties

General | Codes | Details | Visitor's Options

Visitor ldentification

Visit Date,/Time
4/ 327
15585 £

Hosted
Department

Automatic Disable on Exit
Access fArea

None

Options
@ Inactive Card
Unauthorized User

Unassigned Card

[None

Comment

J

Cancel

3. Enter the visitor specific options as needed.
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4. Enter the visitor’s details in the various tabs as explained in detail in the user subsections.
5. Click OK.

The window closes and the new visitor appears in the Display Area.

=1 Users may be moved to other department or redefined as a Visitor. A visitor may be moved
into any department and changed to a regular user. These can be done by using the General tab
and selecting the new department to which you wish to the user or visitor.

6.14.7. Associating a User to a Card

Once users and cards have been added to the system, you must associate each user to a card.

To Associate A User To A Card:

1. While in the User Properties window, click the Credentials tab.

User Properties !
General Credentials  Details
Details

Protocol Issue Number Site Code Facility Code Card ID Credertial Type Details Status
Wiegand 26 bits v prdl 801 Fingerprint ~|R2 Bio8000 |Active |v
Wiegand 26 bits ~ 111 2222 BLE w Active w
Wiegand 26 bits ~ 123 2333 Card v Active  |v
Wiegand 26 bits ~ a1 4444 UHF ~ Active ~
Wiegand 26 bits ~ 122 5555 NFC v Active  |v
Wiegand 64 Bits ~ 32247214414883717... | License Plate ~ | AB-123CD Active  |v
e Wiegand 26 bits ~ Card ~ Active |~
| B | ‘ R T | | Envollfrom Desktop Reader ‘ | Ercliomoeen P | | Add from List |
PIN Code Duress PIN Code
Number of Digits {4 to 8) Code Number of Digits {4 to 8) Code
" E — T < — T
[ Mew ok || canced |
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2. Click Add from List.
The Add Cards window opens.

Available Cards Selected cards

0. 000000000000002
0. 000000000000004
0. 00000000000000%

o
-\_ﬁ

e

0K || Cancel

3. Selectthe card(s) from the Available Cards list you wish to associate with the user and move them to
the right panel using the arrows.

[ N Ifacard has already been associated to this user, it appears in the Selected Cards list. ]

4. Click OK.
Alternatively, you can open the Add Cards window using the Tree View.
5. Inthe Tree View, expand the Users element and expand the Departments/Users element.

6. Select a department that contains the users you wish to associate with a card and select a user from the
table.

7. Click the m icon.

6.15. Adding Global Antipassback Rules

Global antipassback functionality is only enforced when the AxTraxNG Server is connected and monitoring
the entire access control system.
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3 A global antipassback rule can only be added if an access area has previously been defined
(see Section Adding Access Areas).

To Create Antipassback Rules:

1. Inthe Tree View, click Global Antipassback.

2. Onthe toolbar, click the + icon.

The Global Antipassback window opens.

Global Antipassback =

Description

Slobal Antipassback 1

Access frea
| Access Area 1.1 v
Automatic Antipassback

== 7

(") Hard (glam and access denied)

@ Soft (alam only)

| ok || Cancel

3. Inthe Description field, enter a name for the antipassback rule.

4. From the Access Area drop down, select the access area.
From the Automatic Antipassback drop down, select the time zone for which the global antipassback
applies.

6. Select either the Hard or the Soft Antipassback option.

7. Click OK.

The window closes and the global antipassback rule appears in the Display Area.
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= Global Antipassback applies an Antipassback event only on "Enter” readers to the defined
"Area".

To implement Antipassback on Exit readers as well, you must define a new area with opposite
reader directions:

Readers defined "Enter" in the first area need to be defined again in the new area as "Exit"
readers, and "Exit" readers in the first area should be defined as "Enter" readers in the second
area.

_ J

6.16. Adding Car Parking

The Car Parking management option allows you set up groups that have limited number of users who can
access a particular area. For example, a parking lot that serves several companies and each company has
a specified number of parking spots. With this option, we can set up each company’s limit and when the
limit is reached, access is no longer granted. This feature is counter based that keeps track of the number
of users in a specified area.

e A

= This feature is not available to AC-215 access control panels.

= Only one car park area can be added per panel.

= Acar parking area can only be added if an access area has previously been defined (see
Section Adding Access Areas).
\ J

To Define A Car Parking Area:
1. Create an access area with Enter and Exit readers (see Section Adding Access Areas).

2. Inthe Tree View, click Car Parking.

3. Onthe toolbar, click the + icon.

The Car Parking window opens.
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Car Parking 3

Description
Car Parking 2

Access Area
|Amsﬂrea 1.1 -

Checked by Area Maximum Counter
@ Access Area 1

A0k

1 User Groups

Fesst QK | | Cancel

4. InDescription, enter a name of the car parking area.
5. In Access Area, select the relevant access area that you defined in Adding Access Areas.
6. Inthe Checked by area, perform one of the following:
a. Select Access Area.
i. In Area maximum counter, select the number of parking spots available in that access area.
ii. Click OK.
b. Select User Groups.
i. Click OK.

ii. Inthe Tree View, expand the Car Parking element and select the car parking area you just

created.

iii. Onthe toolbar, click the :+ icon.

The Car Parking Group window opens.
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Description

Group Mumber Group madmum courter

[ sz i =

| Aeset || New || ok || Cancel |

iv. InDescription, enter a name of the car parking sub-group.
v. In Group maximum counter, select the number of parking spots available for the parking group.
vi. Click OK.

vii. Inthe Tree View, expand the Departments/Users element and select a department that contains
the users you wish to add to the Car Parking sub-group.

viii. Select a user inthe Display Area.

ix. Onthe toolbar, click the I?l icon.

X. Onthe General tab of the User Properties window (see Section General Tab), select the Car
Parking sub-group from the Car Parking Group drop down.

xi. Click OK.
The window closes and the new car parking group appears in the Display Area.
xii. Repeat Steps viii to x for each user you wish to add to a particular Card + Card group.

xiii. Repeat Steps iii to vii for each group that you wish to add to the car parking area.

6.16.1. Viewing and Editing Car Parking Counters

Once you set up your various car parking groups and areas, the counters for these groups and areas can be
easily viewed and edited.

To view and edit the Car Parking counters:

1. Inthe Events toolbar (above the Event Log area), click the E icon.

The Car Parking Counters window opens.
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lﬁ

Car Parking
[Cz—.r Parking 2 "’l Area Maximum Counter Area Cument Counter

[] set New Counter ] Set New Courter

o H | [
Car Parking Groups

Group maximum counter Group cument counter

'] Set New Counter Set New Counter
o H H
[ ok [ Coned |

2. Update the maximum or current counters of either the car parking areas or the car parking groups,
depending on how the car parking element is defined.

The values of the maximum counters entered in this screen override the values of the maximum
counters that you entered in Section Adding Car Parking.

3. Click OK.

6.17. Adding Operators

Operators are people with access to the AxTraxNG application. The default operator name is
Administrator.

Different operators have wider or more restricted security rights, from complete control over the system
to the ability only to view one section. All operator passwords are case-sensitive.

AxTraxNG™ V27.7.x.x User Guide 107



ROSSILNR=

6. Setting Up a Site

To Define Operators:

1. Inthe Tree View, expand the Users element and select Operators.

2. Onthe toolbar, click the + icon.

The Operator Properties window opens.

Operator Properties n
Description

|[ Auto Logout : {minutes)
] Localize guard Metwarks. . Status Maps...
Location Rights

Read e

Metworks Read ~
Corfiguration Read e
Operators Read e
Isers and Cards Read o
Visitors Read w
Reports Read e
AuTime Mone o
Password... OK || Cancel

In the Description field, enter the Operator’s name.
Auto Logout - to define the time in minutes the AxTraxNG Client will logout.
Select Localize guard to define the operator with limited rights.

Click Networks... and Status maps... to define the associated operator’s local rights.

N o o M W

Set the operators global permission rights for each of the screens in the Location list.
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8. Click Password... to open the Operator Password dialog.

Operator Password [
Change Password

Current Password

MNew Password

Confirm Password

Mote: Password will be saved
together with other properties of
the operator.

| ok || Cancsl

9. Enter the operators’ password in the Password field and re-enter the password in the Confirm

Password field.

= Onfirsttime use, leave the password field empty and enter (and confirm) your new

password.

10. Click OKto save your settings.

The dialog closes and the operator is shown in the Display Area.

6.18. Creating Elevator Control

Normally, a reader is associated with a door. For elevator control, a selected reader should be associated
with outputs groups, with each output group representing a floor.

To create elevator control:

1. Select areader (see Section Configure the door as required.) in the Display Area.

2. Onthe toolbar, click the I?i icon.

3. Onthe General tab in the Reader Properties window, clear Activation.
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Achivation: [ ] Open14Panel 15Door 2

4. Click OK.
5. Create output groups (see Section Adding Output Groups).

Each output group represents a floor or several floors.

-~ When creating an output group for the elevator control, the selection only applies to outputs

from the same panel.

6. On the General tab of the User window, associate a user with the relevant output groups (see Section
General Tab).

Each user can be associated with the relevant output groups to allow user access to specific floors, as
needed.

7. Create a panel link (see Section Adding Panel Links). Only one panel link is required.

6.19. Creating Status Maps

The Status Map displays the status of every door, input, and output, antipassback rules, and alarms in the
facility on user-selected floor plans.

To Set Up A Status Map:

1. Inthe Tree View, select Status Map.

2. Onthe toolbar, click the + icon.
The Add Status Map window opens.
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Status Map 2

Design Mode

T

3. Right-click in the window and select Set background from the shortcut menu.

The Select Picture File window opens.

N
= To change the map image and/or to add objects on the map, you must select Design
Mode. The Add Map icon on the toolbar is enabled.
J
4. Select a graphic file (bmp, jpg, gif, or tiff) for the Status Map background.
N
- Status mapicons can also be added to other status maps, indicating where the two map
areas meet.
J
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Status Map 1
o

5. Ensure that Design Mode is checked.

6. From the Tree View, select readers, doors, inputs, outputs, additional status maps, cameras, or panels
and click the Add to Map icon from the toolbar menu.

The objects appear on the status map, and can be dragged to their correct positions.
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7. Right-click a map object and select Show on Map from the shortcut menu.

The Show on Map window opens.

Alarm
Status

[ ok || cancel |

8. Select Status to display the object’s state on the status map.

 Show On Map—3\Panel\Door @
Alarm

Status
By Ouput (") By Door Manitor

| oK || cancel |

9. For adoor's Show on Map properties, select:
a. By Door Monitor: Shows the doors open status based on its physical position.

b. By Output: Shows the doors open status based on the status of its lock.

10. Select Alarm to enable a visual alarm on the map for alarm events.

= The alarm option is only available for panel elements where the alarm was already defined
(refer to the Generate Alarm field in the table in Section Adding Panel Links).

11. Repeat step 6 to 10 as required.

12. Repeats step 1to 10 to set up additional status maps.

=1 Status map icons can also be added to other status maps, indicating where the two map areas
meet.

AxTraxNG™ V27.7.x.x User Guide 113



ROSSILNR= 6. Setting Up a Site

6.19.1. Manually Opening a Door from Status Map

You can manually open a door while in the Status Map interface.

To Manually Open A Door From The Status Map:

1. Clear Design Mode in the lower left corner of the status map.
2. Right-click on a door that appears on the Status Map.

The following window opens.
Options

) Open momentariy {closed by timer) {min:sec)

() Open permanently (closed by ‘Close output and retum to default mode?)
@ Close output and retum to Default mode

[_#opy || Concel ]

The available options are the same as those in Section Controlling the Door Manually.
3. From Options, select the option you want.

4. Click Apply.
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7. Card Design (Photo ID)

AxTraxNG allows you to design badges for mass printing and supports connectivity with digital cameras
for image capture.

This chapter instructs installers and users how to use the Card Design element.
7.1. Creating a Card Template

To Create A Card Template:

1. Inthe Tree View, expand the Users element.

2. Expand the Cards element and click Card Design.

3. Onthetoolbar, click the + icon.

The Card Design - Template screen opens.

Card Design - Template a

Description

|
Scale Orientation

@ Inches @ Landscape

) Centimeaters ) Portrait

Size

@ D Card (3.3707* 2.1257)
) 150 Card (3.375"* 2.1757)

) Customized (size set by user)

Width Height
400  Inches (Max 4.00) 3000 Inches (Max 3.00)
[ cmack [ Nea> | | ok [ cancel

4. Enter a description for the template and define the scale, orientation, and size.
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5. Click Next.

The Card Design - Fields screen opens.

Card Design - Fields =

=
o
]

-ard Number|

ser Number -

irst Name

—_
=}
|

I
=
|

FIENGAEITG

alla @
B %%glﬁ
._ SRIERE E
I
1
D t

Static fields
tatic field 16

I

Click and drag the components from left and place them in the card area. Press Cid
® ' ey and click to sign muttiple components. Use right-click to change the properties.
[

6. Right-click the card area background to set the background color or to select a file to use as the
background.

Background
Transparent
Edit

7. Asdesired, drag the fields on the left into the card area to create the layout of the card.
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8. Right-click on any field appearing in the card area to show the following menu options:

Font
Background
Transparent

Properties

Left Align
Center
Right Align

Edit
Delete

9. Click Properties to remove the border and change the field size.

[
M

Border
Position Size
Top Height
0.450 (Max 2.125) 0208 (Max2.125)
Left Width
0.135 (Max 3.365) 1354  (Max3.365)

ok || cancel

10. Click OKto returnto the Card Design - Fields screen.
11. Click OK to save the card template.

7.2. Printing a Card

Once you have saved a card template, you can print cards using the template.

For best printing results, it is strongly recommended to use 300 dot per inch (dpi) and a high screen
resolution (at least 1280x1024 for a portrait card or 1600x900 for a landscape card). A resolution of
1920x1080 is recommended.
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To Print A Card:

1. From the card template list in the Display Area, select the template you wish to use and click the @
icon.

The Print Card — Selection window opens.

Print Cards - Selection

The Print Card wizard will help you to print
cards in a pre-designed card layout.

Which card layout do you want to print?

| Card Design 1 -

You can press back at any time and
change your selection.

Cancel < Back Mext = Print Al Print preview... Print...

2. Select the layout you wish to use (if different than what you selected in Step From the card template list
in the Display Area, select the template you wish to use and click the icon. from the corresponding drop
downs.

3. Click Next.

The Print Card — Users List screen opens.

= For users to appear in the Available list, they must have cards associated with them as
described in Section Associating a User to a Card.
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Print Cards - Usershit @

Available Selected

General
smith, john {1}
doe, jane (2}

Cancel ][ = Back ][ Mext = ][ Print All H Print preview... H Print...

4. Select the users from the available list for whom you wish to print a card and move them to the right
panel using the arrows.
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5. Click Next.

The Print Card — Preview screen opens.

Print Cards - Preview n

& |

|F{usslare |

|F{usslare |

Add photo ] Print the photo on the back side

Cancel || < Back MNext = Print All Print preview_ . | | Print...

6. Change the barcode type:

a. Right-click on the Barcode field and select Barcode.

| Earcode
| Delete

The Barcode Parameters window opens.
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Barcode Parameters n
Barcode Mumber
Random
76524076 ®
() User Number
Choose Alphabet Coding: |CODE'IEE "
QK Cancel

You can use the barcode that is generated automatically or enter a numeric barcode manually.
By choosing User Number the Barcode will be same as the user number

b. From the Choose Alphabet coding drop down, select the kind of coding.

ASTEC
CODABAR
CODE128

CODE128C
DATAMATRIX
DATAMATRIXASCI
DATAMATRIXBASEZ256
DATAMATRIXCAD
DATAMATRIXEDIFACT
DATAMATRIXTEXRT
DATAMATRIXX12
[20F5

QRCODE
QRCODEALPHANUMERIC
QRCODEEBIN
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c. Click OK.

The barcode appears on the card template.

Print Cards - Preview n

| [ Printthe photo on the back side

o | [ o

AxTraxNG™ V27.7.x.x User Guide 122



ROSSINR= 7. Card Design (Photo ID)

7. Click Add photo if you wish to select a different image either from a file or from a PC camera:

The Select Source window opens.

Capture Image

a. Do one of the following:

* Select Browse to locate an image to insert.
* Select PC Camera and select Capture Image.

a. Click OK.

8. Use the green arrows to preview additional users.

9. [Optional] Click Print preview to show the enlarged card screen.

AxTraxNG™ V27.7.x.x User Guide 123



ROSSINR= 7. Card Design (Photo ID)

10. Click Print to print that particular card or click Print All to print all the available cards.

AxTraxNG™ V27.7.x.x User Guide 124



ROSSLNR=

8. Video Integration

8. Video Integration

Cameras can be added to the network to allow real-time viewing of any area desired.

ViTrax is a video management server client solution that supports a wide range of IP, USB, and open
protocol cameras, such as OnVif and PSIA. Be sure that the ViTrax Server is installed on a PC and you
know that PC’s IP address.

The video integration can also be done with Hikvision or Dahua servers.

The functionality will be discussed in future versions of the manual.
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9. Manual Operation

In additionto AxTraxNG's automated access control network monitoring and control, there is the option to
manually control the network directly.

= Door Manual Operation can only control doors that have been set as “Manual Door Open

Enabled” in the Door Properties window (see Section AC-825IP).

9.1. Controlling the Door Manually

The Manual Door Operation window allows an operator to open or close a selected group of doors
directly.

To Manually Open Or Close A Door:

1. Inthe Tree View, expand the AC Networks element.
2. Expand a network and expand a panel.

3. Select Doors.

4. Onthetoolbar, click the :l icon.

The Manual Door Operation window opens.

Cptions
() Open momentarily (closed by timer) 0:04 [ (minsec)
() Open pemanently (closed by Close output and retum to default mode)
@ Close output and retum to defautt mode

Location Description Details [ Select All ]
'E T\Panel 1 1\Panel 1\Door Default _
E 14Panel 2 14Panel 2*Door Default

ey J[ GCose |

5. Sortthe listed panels/doors in regular or reverse order, by clicking the column header with the left
mouse button.

6. Selectan option:

Open momentarily — Open all selected doors for the time set in the timer box
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Open permanently — Opens all selected doors
Close output — Closes all selected doors and returns control to AxTraxNG

7. Select the checkboxes of those doors to which to apply the operation.
8. Click Apply.

9.2. Changing the Reader Mode

The Manual Reader Operation window allows an operator to change the operation mode of a reader.

Readers have eight possible operation modes:
* Inactive: The reader is notin use.

Card Only: The reader accepts cards only.

PIN Only: The reader accepts PIN inputs only.

Card or PIN: The reader accepts both cards and PINs.

Desktop: The reader is inactive, but can record new cards for the AxTraxNG database.

User Dual Authentication: The reader grants access only for 2 credentials per user per access

1 The AC-215A panel does not support User Dual Authentication mode, and instead supports

Secure (Card + PIN) mode.

No Access: The reader does not grant access to users.

Card + Card: The reader grants access only when two separate users present their cards.

| The AC-215A panel does not support Card + Card mode

To Change The Reader Mode Manually:

1. Inthe Tree View, expand the AC Networks element and expand a selected network.

2. Select a panel.

3. Onthe toolbar, click the icon.

The Manual Reader Operation window opens.
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Reader Options

(") Change operation mode | Inactive - |
Default

1"Panel 1\Reader 1 [ Select Al ]
1"Panel 1"Reader 2
| Select None |

oKk || cancel

4. Select an option:

* Change operation mode — Resets all selected readers to the selected operation mode.

* Default — Returns control of the readers to the system.

5. Select the checkboxes of those readers to which to apply the operation.
6. Click OK.

9.3. Controlling Outputs Manually

The Manual Output Operation window allows an operator to open or close a selected group of outputs on a
panel directly.

To Manually Open Or Close An Output:

1. Inthe Tree View, expand the AC Networks element and expand a selected network.

2. Select a panel.
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b o
3. Onthe toolbar, click the = jcon.

The Manual Output Operations window appears.

Manual Qutput Operation (3]
Cutput Options
(") Open momentariy (closed by timer) {min:zec)

() Open Permanertly (closed by Close output and retum to default mode)
@ Close output and retum to Default mode

1\Panel 1.Door Select Al

T%Panel 1"Dutput 1A _

1\Panel 1"Output 2 Select None
1%Panel TWOutput 24

0K || cancel

4. Select an option:

* Open momentarily — Opens all selected outputs for the time set in the timer box.
* Open permanently — Opens all selected outputs.

* Close output and return to default mode — Closes the selected outputs and returns control to
default.

5. Select the check boxes of the outputs to which to apply the operation.
6. Click OK.
9.4. Manually Disarming Inputs

The Manual Input Operation window allows an operator to disarm a selected group of inputs directly on a
panel.

An armed input means the input is active; a disarmed input is inactive and does not trigger any operation or
alarms.
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To Manually Disarm Or Rearm An Input:

1. Inthe Tree View, expand the AC Networks element and expand a selected network.

2. Select a panel.

3. Onthe toolbar, click the = icon.

The Manual Input Operations window opens.

I—ﬂ
Manual Input Operation

Input Options
) Input permanentty disarmed
i@ Am input and retum to Default mode

1"Panel 1\Door REX [ Select Al ]
1%Panel 1\Door Monitor
1"Panel 14Spare Input 2 | Select Nore |
1%Panel 145pare Input 24

0Kk || Ccancel

4. Select an option:

° Input permanently disarmed — Deactivates all selected inputs.

* Arm input and return to default mode - Reactivates the selected inputs and returns control to
default.

5. Select the checkboxes of the inputs to which to apply the operation.

6. Click OK.

9.5. Controlling Sirens Manually

The Manual Siren Operation window allows an operator to test the siren for a selected panel.
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To Manually Open Or Close A Siren:

1. Inthe Tree View, expand the AC Networks element and expand a selected network.

2. Select a panel.

3. Onthe toolbar, click the ‘3 icon.

The Manual Siren Operations window opens.

|—|m
Siren Cptions
() Open momentarily (closed by timer) {min-sec)

@ Close siren and retum to Defautt mode

4. Select an option:

* Open momentarily — Sounds the siren for the time set in the timer box.

* Close siren and return to default mode — Silences the siren and returns control to default.
5. Click OK.

9.6. Updating Firmware

The Update Firmware window allows an operator to update the firmware version of the selected access
control panel. For AC-825IP panels, you can also update the firmware of the connected extensions.

9.6.1. AC-215x, AC-225x, and AC-425x Panels

To Update The Firmware:
1. Inthe Tree View, expand the AC Networks element and expand a selected network.

2. Select a panel.

3. Onthe toolbar, click the % icon.

The Firmware Update window opens.
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m

Panel Type known on PC

AC-225B

Are you sure you want to update the fimware of the panel 1\Panel 17
Fimware files

[c225Bv05_00_01 hex -

From the dropdown, select the HEX file relevant to the panel’s hardware type.

Click OK.

A progress bar runs at the bottom of the screen until the firmware update is found and then a pop-up
appears stating the update has begun.

M

o The fimware update has started.

To see the progress of the update, select the network in the Tree View and look at the Downloads
columnin the Display Area.

Status Downloads
Connected MED 455 |

The updated finishes when the number of downloads reduces to zero and then no longer appears in the
column. The status of the panel is now “Connected”.

Status Downloads
Connected

9.6.2. AC-825IP Panel

To Update The Firmware:

1.
2.

Inthe Tree View, expand the AC Networks element and expand a selected network.

Select a panel.

On the toolbar, click the % icon.

The Firmware Update window opens.
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Firmware Update 1\Panel AC-825IP =]

Panel Type known on PC

AC-B25IP @ AC-825

Are you sure you want to update the fimware of the panel 1\Panel AC-825IP 7 () Bxtensions
Firmware files

[Acs25v02_07_15hex -

Address Description System Status FW Version Frogramming Status Note
2 1\Panel 2 Unknown “You must tum off the power before pressing ‘0K and then tum the power back on.
)3 1\Panel 3 Unknawn You must tum off the power before pressing ‘0K’ and then tum the power back on.
0|4 1\Panel 4 Unknown You must tum off the power before pressing ‘0K’ and then tum the power back on,
1|5 T\Panel 5 Unknawn You must tum off the power before pressing ‘0K and then tum the power back on.
=i 1\Panel & Unknown You must tum off the power before pressing 0K’ and then tum the power back on,
)7 T\Panel 7 Unknown You must tum off the power before pressing ‘0K and then tum the power back on.
s 1\Panel & Unknown You must tum off the power before pressing DK’ and then tum the power back on
=E 1\Panel 9 Unknown “You must tum off the power before pressing ‘0K and then tum the power back on.
[ |10 1\Panel 10 Unknawn You must tum off the power before pressing ‘0K’ and then tum the power back on.
[ |11 1\Panel 11 Unknown You must tum off the power before pressing ‘0K’ and then tum the power back on,
12 1\Panel 12 Unknawn You must tum off the power before pressing ‘0K and then tum the power back on.
|13 1\Panel 13 Unknown You must tum off the power before pressing 0K’ and then tum the power back on,
)14 T\Panel 14 Unknown You must tum off the power before pressing ‘0K and then tum the power back on.
s 1\Panel 15 Unknown You must tum off the power before pressing DK’ and then tum the power back on
|16 1\Panel 16 Unknown “You must tum off the power before pressing ‘0K and then tum the power back on.
|17 1\Panel 17 Unknawn You must tum off the power before pressing ‘0K’ and then tum the power back on.
o

4. By default, the main panel is selected to update.
@ AC-825
") BExtensions

5. From the dropdown, select the HEX file relevant to the panel’s hardware type.

6. If you select Extensions to update an expansion’s firmware, then you must also select which expansion
you wish to update.

Address Description System Status FW Version
2 4\Panel 2 Enable 03 50
[]3 4'Panel 3 Unknown
-

You can only select one panel at a time to update.

7. Click OK.

A progress bar runs at the bottom of the screen until the firmware update is found and then a pop-up
appears stating the update has begun.

1\Panel AC-325IP 3]

The fimmware update has started.
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8. To see the progress of the update, select the network in the Tree View and observe the Downloads
column in the Display Area.

Status Downloads
Download firmware A (1164 128 |

The updated finishes when the number of downloads reduces to zero and then no longer appears in the
column. The status of the panel is now “Connected”.

Status Downloads
Connected
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10. Reports

=1 When printing a report, be sure that the default printer is a standard printer and not a special

printer for printing cards; otherwise, the reports may not print correctly.

10.1. Types of Reports

AxTraxNG includes four main categories of reports and each category contains multiple kinds of reports.

Immediate Reports - Lists details of recent movements (within the last few hours). They are shown in
the Display Area and can be exported.

Panel Reports — Displays details of all recorded panel events
System Reports — Lists details of system and operator activity

Interactive Report — Lists details of users and their access activity

10.1.1. Immediate Reports

There are four types of immediate reports:

Who's been in today - Lists where and at what time each user was granted access for the first time
today.

Last known Position — Lists where and at what time today each user was most recently granted
access.

Roll-Call Readers - Lists the last time each reader was given access, and by whom, within the last 1-
99 hours.

Roll-Call Areas - Lists all users currently within the selected area, sorted by department and entry time.
The report lists all personnel who entered the facility within the last 1-99 hours.

Access Area Occupancy - Lists all of the personnel in the designated access area

10.1.2. Panel Reports

Panel reports display details of all recorded panel events.

There are seven available panel event reports:

° Attendance Report - Lists the attendance hours for selected users, sorted by date. Results include
hours present, time in, and time out.

* AC Panels Report — Lists all the events recorded by the selected AC panels, sorted by date.

* Access Report - Lists all access events recorded by the selected readers, sorted by reader and date.
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Readers Report — Lists all users who have accessed the selected readers, sorted by department and
date.

Bio Terminals— Lists specific Biometric terminals events, sorted by terminal and date.

Visitors— Lists visitors who have made a visit to a certain user or department, or lists all related
visitors.

10.1.3. System Reports

System reports list details of system and operator activity.
There are three available system event reports.

System Report — Lists all operations performed by the AxTraxNG server, sorted by date.

Operators Report — Lists all the operations performed by registered system operators, sorted by
operation event type and date.

Alarm and Antipassback Handler Report — Lists all raised system alarms, sorted by operator and
date.
10.1.4. Interactive Report

Interactive reports list details of users and their access activity.

There are three available interactive reports:

User Access Rights Report — Lists site access details for selected users, with full details of readers
accessed and in which time zones.

Not Responding Users Report - Lists users for whom there have been no access events for a
selected period of time.

AC Panel Links Report — Displays the links in the system per selected access control panel.

10.2. Generating a8 Report
To Generate A Report:

1. Inthe Tree View, select the Reports element.

2. Select one of the four main report categories.
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-'I';.I,:- Interactive Reporis

User Access Rights

Mot Responding Users
AC Panel Links Report

3. Select areport type from that category.
Depending on the category and type of report selected, the relevant parameters appear in the Display
Area.
For example, the parameters needed for the User Access Rights Report are displayed.

I Interactive Reports Interactive Reports - User Access Rights

User Access Rights |-”+\| Users 1

Mot Responding Users |’+\| Readers 1
AC Panel Links Report
\.1.\1 Fields

User special fields
[] UserID

[] User Credentials

- A parameter in red must be selected while a parameter not in red is optional.
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4. Click on a parameter to expand it.

i ey
| = Users

Search

2% General

2% Visitors
doe jane
Janes don
smith bill
srnith john

Search

5. Select and move the desired entities using the arrows.

6. Once all the entities in each parameter have been selected, click the & icon on the Toolbar to generate

areport.

The generated report, in this example the User Access Rights Report, appears in the Display Area.

B

Not Responding Users
AC Panel Links Report

H\Panel AC-825\Reader 2 (In)
4\Panel AC-825\Reader 2D (It
H\Panel AC-825\Reader 3 (In)
4\Panel AC-825\Reader 3D (I
H\Panel AC-825\Reader 4 (In)
4\Panel AC-825\Readler 4D (I
£\Panel AC-825\Reader 5(0SI
4\Panel AC-825\Reader 6(05I @

—
20 Selected
1= Fields
Search Search
EY
ra
S

4 Interactive Reports

User special fields
[ Userlp
[] User Credentials

[

Deperment = | User Number_ ~ [serNome -~ [ access Gro

Reader Name Day Start Date End Date Time Zone
T
|» B Department Genersl
| | |® UserNumber1
B B User Name: smith, john
- B Access Group: Master
B ] Date: 4/4/2016 120000 AM
| 8 un
| L\Panel AC-82.. Al Days 0000 2359 Aweys
| 1\Panel AC-82.. All Days 0000 2359 Ahways
B 1\Panel AC-82.. All Days 00:00 2359 Always
B 1\Panel AC-82.. | All Days 0000 2350 Always
B 1\Panel AC-82.. | All Days 0000 2350 Always
| 1\Panel AC-82.. All Days 0000 2359 Aweys
| 3\Panel 1\Read... All Days 0000 2359 Aways
B 3\Panel 1\Read... All Days 00:00 2359 Always
|| 3\Panel 2\Read... | All Days 0000 2350 Always

10.3. Scheduling a Report

Once you have generated a report for the first time, you can schedule the same report to be generated and
saved automatically at a time interval of your choosing.
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To Schedule A Report:

1. With the generated report appearing the Display Area, click the E icon on the Toolbar.

The Save Report window opens.

Mame

Description

[ ] Scheduling

[ ok | [ concel |

2. Enter the name and description of the scheduled report.

3. Select Scheduling to expand the options.

Mame

Description

[# Scheduling

File Access

Every 1% Days

At 0939:52 ¥ | x|

Start from 03 April 2017 3 |*|
[]To . |1]

Emails

Recipients

Max File Size

| ok | | cancel

4. Using the available fields, set the parameters (format, interval, period of time, email recipients) for the
scheduled report to be generated.
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= Inorder to use email notifications, you must configure the SMTP settings (see Section
Options).

5. Click OK.

The saved report appears in the Display Area.

Report Id Report Categ...  Report Type

To access the list of saved schedule reports at any time, click the @ icon on the Toolbar.

To delete a scheduled report, select that report in the Display Area and click the E icon on the Toolbar.

Reports that are automatically generated as scheduled are saved to a default location, which is set in the
AxTraxNG Server Monitor (Appendix Options).

10.4. Previewing a Report

You can preview a generated report in order to save or printit.

To Preview A Report

1. Onthe Toolbar, click the @ icon to preview the report.

A separate window opens showing the report.

# User Access Rights
I Department : General
I Department : Visitors

AxTraxNG 27543 User Access Rights

5/11/2017 10:28:534
AM

Rosslare

General
1

Department :

User Number :

User Name : smith, john

Access Group : Master

Valid Date : 4/4/2016 12:00:00 AM
Until =

Reader Name End Date

Day

1\Panel AC-825Reader 1 All Days 100:00:00 23:58:39 Always
1'Panel AC-825'Reader 2 All Days 00:00-:00 23:59:59 Always
1\Panel AC-825'Reader 3 All Days 00:00:00 23:59:59 Always

1'Panel AC-825'Reader4 All Days 00:00-:00 23:59:59 Always

The available icons for each type of report preview are described in the following table:
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Icon Name Click Button To...

1 Report Map Map the report according to the different groups
% Search Search for text in the document
E Open Open a pre-saved reports
E Save Save the report document
‘g Print Print with adjustable settings
& Quick Print Print the document with default settings
Page Setup Adjust the documents settings
Scale Adjust the scaling of the page
=
@ Zoom Out To view more of the page
=
K@l} Zoom In To enlarge the script on the page

100% -

Percentage box

Choose the percentage you wish to zoom in/out in.

Export
document

With the arrow to the right, choose in which format you wish the
document to be exported.

< h%j'

Send via email

With the arrow to the right, choose in which format you wish the
document to be saved and then sent via email.
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11. Administrator Operations
11.1. Setting the Time and Date

You can select panels by network and reset their date and time to the AxTraxNG server's system date and

time, using the Set Time window.

To Reset The Panel Time:

1. Inthe Tree View, expand the AC Networks element and select a network.

2. Onthe toolbar, click the B icon.

The Set Time window opens.

PC
[ 4 47207 @~ [1339 E

Custom Date/Time

| Deseription Status DateTime Note [ [

3. Select the panels to reset.

4. Click Apply.
The server connects to the panels and sets the time as requested. A dialog confirms the operation.

11.2. Testing User Counters

When using User Counters, it is possible to view the current user count value in each panel that has a reader
designated with the "Deduct User" option.
To View User Counters:

1. Inthe Tree View, select expand the Users element.
2. Select the Visitors element or expand the Department/Users element and select a department.

3. Select auser or visitor in the Display Area.
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4. Onthetoolbar, click the é} icon.

The Request User Start window opens.

Panel Panel Status | Counter Status | Courter Value Note [ [ selectmn |
1\Panel AC-825

-_Ted. -Cmcd.

-
% For a panel to appear in the table, that panel must have at least one reader for which the
Deduct User Counter option on the General tab of the Readers Properties window (Section

General Tab) is selected.

_
5. Select the panel(s) you wish to test.

6. Click Test.

A progress bar runs at the bottom of the screen and a confirmation message appears when the test

finishes.
7. Click OK.

The remaining fields in the table are now populated.

Panel Parel Status Courter Status Courter Value Note. |[ seeam |

11.3. Maintaining the Database

E Itis highly recommended that you back up the system database to an external storage device
once a week (see Section Maintaining the Database).
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Use the Database window to maintain the system database.

To Open The Database Window:

1. From the menu bar, select Tools > Database.

The Database window opens.

Database [E]
Select Database Options
[Badmp Mow v]
Backup Mow

Backup Folder (PC - SAM-PC1)
‘C:\F‘mgmmData\Hnsslare Enterprises Ltd"Ax TraxMNGY27.5.0.4Backup

Browse...

Mote: The Database file name will be appended with _feTranc1_w19

Backup File Prefoc

| ok || Ccancsl

2. From the Select Database Options drop down, select your required option, as described in the
following table:Table 18: Tools > Database > Available Databases

Operation | Description

Run a scheduled backup every specified number of days at the specified

Periodic Backup time

Backup now Run a onetime backup immediately.

Export Configurations and

Copy the contents of the database to the selected folder.
Events*

Replace the current configuration based on the imported file.
Import Configurations*

A user’s photo can also be imported.
Import Configurations and

Events Replace the current configuration and events based on the imported file.

Erase Configuration and

Erase the current database configuration and all events.
Events*
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Operation Description

Automatically erase events when they are older than a specified number of
days.

Before using this option, Rosslare recommends that you set a periodic
Limit Panel Events Period backup.

= | It is recommended to set the value to no more than 91 days.

Erase Panel Events Erase all events that are older than a specified number of days
Import earlier database from Replace the current database with an AxTrax database
AxTrax* (AS-525) A user’s photo can also be imported.

Replace the current database

A user’s photo can also be imported.

Import earlier database

versions from AxTraxNG A This option does not allow importing a database from a
current AxTraxNG version.
Export Access Events Copy the Access events content of the database to the selected folder.

*This option is only available in the AxTraxNG PC.

3. Click Browse to search for the file to import or to select the folder to export to.

s )
= If youwish to import a DB file, the file should be located in the C:\ProgramData\Rosslare
Enterprises Ltd folder. You may need to show all hidden files to see the ProgramData
folder.
\ J
e R
- The Backup and Export functions add “_AxTrax1_vX" to the end of file name of the
exported or backed up database. The Import Database function executes only with a file
that contains this string at the end of the file name. After a database is imported, the panel
status may change to disabled. If this occurs, the operator should re-enable the panels.
L J
4. Click OK.

11.4. AxTraxNG Options and Preferences

AxTraxNG can be customized to meet the preferences of the operator using the Options window.

To Open The Options Window:

1. From the menu bar, select Tools > Options.

The Options window has five tabs:
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* General - General startup and presentation settings

* User Custom Fields — Additional user-defined fields for the User Properties window

* Custom Operations — Used to upload users to the system from a text file

* Email Notifications — Used to send a notification of selected events to a list of specified emails

* Company Details - Site details (name and address) that are displayed on the report

11.4.1. General Tab

The General tab includes presentation connection settings.

Options [
General | User Custom Fields I Custom Operations I Email Motfications I Comparty Detailsl
Use Highlight Access Events IUse Highlight Metworles and Panel Status
Known Key

[.NI Users v] [ Select Color l Network Failed
Fanel not responding

Unknown Key
Systern Events Language
[7] Show Download Success [English v]

[ Hide Foreign System Events on this PC

[7] Show Panels communication problems Cards Presentation

[7] Popup on Lost Communication with Panel [C] Hexadscimal

[ ok || cancel

The General tab contains the following fields:

Field Description

From the Known Key drop down, select the desired option and click Select
Color to display selected user information in a custom picked colored

Use Highlight Access Events highlight.
Click Select Color adjacent to Unknown key to define the highlight color for
unknown keys.

System Events>Show Download | Select to add a message to the event history upon successful system
Success parameters download from the AxTraxNG software to the panel.

System Events>Hide Foreign

. Select to see only local administrator and AxTraxNG Server messages.
System Events on this PC

System Events>Show Panel

o Select to have status indicate panel communication problems
Communication Problems
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Field Description

Select to have a pop-up appear if communication with a panel is lost.
System Events>Pop-up on Lost

Communication with Panel After selecting the check box, disconnect the working panel and wait for a

minute or two to see that the pop-up appears.

Click Select Color adjacent to Network failed to define the highlight color for
Use Highlight Networks and network alarms.
Panel Status Click Select Color adjacent to Panel not responding to define the highlight

color for panel communication errors.

Select the system interface language.

Language = | Setting the language to Farsi also changes the date format to
the Farsi date format.

Cards Presentation Changes the display of card details to hexadecimal format.

11.4.2. User Custom Fields

The User Custom Fields tab controls the user-defined fields on the User Fields tab of the User
Properties window (see GeneralSection User Fields Tab).

Options B
| General | User Custom Fields |Cu5tom Operations I Email Notifications I Comparny Deiailsl
Type Description List
« [rex =] I
User Default Valid Time Uzer Photo
From Until @ Database
00:00 2359 B © Extemal files Import from DB
[ ok || cancel

The User Custom Fields tab contains the following fields:

Field Description

Select the type of field.
Type

If Type is list, click Edit List and enter list items.
Description Type a name for the new field.

Set default start and end time for user access rights using the From and Until

User Default Valid Time i
fields.
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Field Description

Define the default photos to be used:

® Database: Use the User photos save in the database

User Photo * External files: Use this option to save a large user photo collection external
from the database

® Export from DB: Click to export existing photos from the database to an
external folder
11.4.3. Custom Operations

The Custom Operations tab is used to upload user data to the system from a text file and to set the
shared database option.

Options
| General | User Custom Fields | Custom Operations | Email Notifications | Company Details

Import User Data from Custom File
Location:

Browse. ..

Period Last Import
0 ] thours)

0" means no import

Shared Database
Share Ao TraxNG to Shared Database
@ TimeKeeper

Exdemal Database

The Custom Operations tab contains the following fields:

Field Description

This option allows you to import visitor user data from a text (*.txt) file.

The data imported is for the following fields: User Number, Last Name, First
Name, Employment Date in dd/mm/yy format, Validity Date (optional).

“n

A " separation must be between the values. Each visitor should be in a new

Import User Data from Custom line of the text file.

File
Select the location of the file to import/export by using Browse.

From the Period box, select the time period.

The period is the time between import processes in hours where ‘0’ means the
import is only in manual operation.
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Field Description

Select to allow sharing the AxTraxNG DB with an external program for the
following data: System Configuration, Departments and Users, Cards, Access
Groups and Database Version.

Shared Database > Share Select the option:

* TimeKeep - Sets the DB sharing for the TimeKeeper program
® External Database - Sets the DB sharing for other generic formats

Shared Database > AxTraxNG Click Import to create a database from the above data from which the data
to Shared Database can be shared by an external program.

11.4.4. Email Notifications

The Email Notifications tab is used to send a notification of selected events to a list of specified emails.

Options B
| General I User Custom Fields I Custom Dpelations| Email Notifications |Compar|3r Deiaj]sl
Enabled
Recipients
yaniv tza@f .com kjds@ds.com
Everts
Access Granted — Any User Access Granted - Selected User
Access Denied - Any User Access Denied — Selected User
Alams * Enable notifications for a user on a user form
Panel Connection lssues
ok [Coma

Enter the email addresses of your recipient(s) and select the events for which you wish them to receive
notifications.

=) In order to use email notifications, you must configure the SMTP settings (see Section
Options).

11.4.5. Company Details

The Company Details tab displays the name and address that are displayed on reports.
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Compary

M

[ General | User Custom Fields | Custom Operations | Email Notfications | Compary Details |

Rosslare

Address

Immedizte Reports

Limit Last Known Position/Muster Reports For The Last Hours

J [ Concel

11.5. Importing/Exporting User Data

The Import/Export Data window makes it possible to import/export user information into/from the
AxTraxNG database from/to a standard spreadsheet file.

@ Import users properties from an extemal file to AxTraxNG
() Export user properties from AxTraxNG to an extemal file

Data Type
Excel Workbook —"xds

M

‘D" - Middle Name

'I' - Telephone

Excel File

Location:

Excel File Columns

*A' - User# findex field) 'F'- Access Group K - Fax P - Title ‘U - Identification

"B’ - First Name ‘G’ - From {Valid date) °L" - Email Q' - Notes V' -—Car Parking Group
'C' - Last Name "H" - Until (Valid date) M’ - Address ‘R'-PIN Code W' - Card+Card Group

°N’ - Home Telephone 'S’ - Cand Number ¥" - Site Code
E' - Department J'~ Mobile 0" - Car Registration T - Faciity Code X - lssue Number
Card Type
Wiegand 26 bits -
Started from
Fie Row Departments Access Groups Car Parking Groups Card+Card Groups
2E = Import Departmerts? Import Access Groups? Import Car Parking Groups? Import Card=Card Groups?
@ Yes () No @ Yes ) No @ Yes ) No @ Yes () No
User Number started from Waming! Car Parking Group can't be
[ created automatically!
| General -] [Master =] [Mone <] [More -]

To Import/export User Data:

1. From the menu bar, select Tools > Import/Export Data.

2. Setthe import/export options according to the field descriptions in the following table:
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Field Description

Import Users properties from

o Select this option to import user properties
external file into AxTraxNG

Export Users properties from ) . .
. ) Select this option to export user properties
AxTraxNG into external file
Data Type Select the type of data file to import/export.
Location Select the location of the file to import/export by using Browse.
Select the check boxes of the columns to be imported or exported.

Data in each column (A-T) are imported or exported as listed.

Excel File Columns
N When exporting the Notes field (Column Q), only the first 256

characters are included.

Excel file Row Enter the first row of user data in the spreadsheet.

Enter the number from which to start assigning unique system user

User number started from
numbers.

Select Yes to import new departments into the AxTraxNG database.
Import Departments?

Select No to import users without their departments.

Select the department to assign to the imported users.

Department This box is only active when the No option is selected in the Import
Departments option.
Select Yes to import new access groups into the AxTraxNG database.
Import Access Groups?
Select No to import users without their access groups.
Select the access group to assign to the imported users.

Access Groups This box is only active when the No option is selected in the import access
group option.

3. Click OK.

11.6. Conversion Table

A conversion table converts the alphanumeric character on a license plate to a binary number that can then
be understood by the relevant reader as a Wiegand input.

To Create A Conversion Table:

1. From the menu bar, select Tools > Conversion Tables.

The Conversion Tables window opens.

AxTraxNG™ V27.7.x.x User Guide 151



ROSSILNR=

11. Administrator Operations

Conversion Tables X
ae+ )
| Search |

D | Description
4 1 Hikvision_DS-2CD4AZ6FWD-IZ5_FW _v54.5 o
-
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2. Onthe toolbar, click the + icon.

The Conversion Tables Properties window opens.

The window closes and the new conversion table appears in the Display Area.

m

Description |a |

Valid Separators | |

Mumber of Bits (NOE) | 1 |-|

Pad Zeroes On The Right [

Alphanumeric Character ‘ Numeric Value Binary Value |

* 0 .

|. Cancel l

3. Set the conversion table options according to the field descriptions in the following table:

Field Description

Description The name of the conversion table

Enter the separator that appears in the license plate.
Valid Separators

“u

A typical exampleis “-“.

Number of Bits (NOB) Enter the number of bits that each alphanumeric character uses

Check if you wish to replace any unused bits in the chosen Wiegand format

Pad Zeroes on the Right
9 with zeroes on the right of the Wiegand code.
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Alphanumeric Character The alphanumeric character appearing on the license plate
Numeric Value The numeric value given to the above alphanumeric character
Binary Value The binary value given to the above alphanumeric character
4. Click OK.
154
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Appendix A. Firewall Configuration
A.1 For Windows 7

The following instructions explain how to configure the standard Windows Firewall for Windows 7.

To Configure The Firewall:

1. Open the Control Panel on your computer.

2. Click the Windows Firewall category. E Windows Firewall
Allow a program or feature

through Windows Firewall
3. Click Allow a program through Windows Firewall.

The Allowed Programs window opens.

Allow programs to communicate through Windows Firewall

Teo add, change, or remove allowed programs and ports, click Change settings.

‘What are the risks of allowing a program te communicate? %/ Change settings
@ For your security, some settings are managed by your system administrator.

Allowed programs and features:

Name Domain  Home/Work (Pri.. Public  Group Policy =
[ BranchCache - Hosted Cache Server (U... O O O Ne
[JBranchCache - Peer Discovery (Uses W... O O O No H
O Connect to a Network Projector m} m} m} Ne =
Core Metworking Ne
[ Distributed Transaction Coordinator m} m} m} Ne
Dropbox Ne
[ File and Printer Sharing m} Ne
Google Chrome No
O HomeGroup O [m] O No
[JiSCSI Service m} m} [m| No
[ Media Center Extenders m} m} m} No
Microsoft Office Outlook O O No ad
.

s

4. Click Allow another program.

The Add a Program dialog appears.
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10.

11.

Add a Program E

Select the program you want to add, or dick Browse to find one thatis not
listed, and then dick OK.

Programs:

Adobe Content Viewer
Adobe Creative Cloud
Adobe Device Central C55.5

B3 adobe ExtendScript Toolkit €55.5
E.ﬁ.dnbe Extension Manager C55.5
n.ﬁ.dnbe Help

Bl 2dobe Tlustrator CC 2017

Il Adobe Tlustrator C55.1

I 2dobe InDesion CC 2017

B 2dobe InDesign £S5.5

-

Adobe Bridge C55.1 "

Path: C:\Program Files (x36)\AdobeAdobe Bridge € | Browse...

What are the risks of unblocking a program?

You can choose which network location types to add this program to.

Metwork location types... l Add I [ Cancel

Click Browse.
The Browse window appears.

In the File Name box, type:

The SQL Server program appears in the Add a Program dialog.
Repeat Steps In the File Name box, type: and Click OK..
In the File Name box, type:

The SQL Browser program appears in the Add a Program dialog.

In the Control Panel, click Administrative Tools.

7] Administrative Tools

The Administrative Tools window opens.

“C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\BINN\sqlservr.exe” and click Open.
Click OK.

“C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe” and click Open.
Click OK.
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Mame

|;j- Component Services
EJ Computer Management
Data Sources (QDBC)

Event Yiewer

E Internet Information Services (I5) Manager

fk, i5CSl Initiator

E:'g Local Security Policy
@ Performance Monitor
ﬁ Print Management
@9 Services

@ System Cenfiguration
@ Task Scheduler

ﬁ Windows Firewall with Advanced Security

Windows Memory Diagnostic
@ Windows PowerShell Modules

12. Double-click Services.

The Services console opens.

Date modified

7/14/2009 6:57 AM
7/14/2009 6:54 AM
7/14/2009 6:53 AM
7/14/2009 6:54 AM
12/26/2013 1:09 PM
7/14/2009 6:54 AM
9/15/2013 4:07 PM
7/14/2009 6:53 AM
9/15/2013 4:07 PM
7/14/2009 6:54 AM
7/14/2009 6:53 AM
7/14/2009 6:54 AM
7/14/2009 6:54 AM
7/14/2009 6:53 AM
7/14/2008 7:32 AM

Type

Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut

Size

2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
2KB
3 KB
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File Action View Help
@ |[E = HE > > 80w
i senices (loca) ([T Genices o
Select an item to view its description, | Name ° Description Status Startup Type log OnAs  *

-%Active)( Installer (... Provides Us... Manual Local Syste.. H
;. Adaptive Brightness Monitars a.. Manual Local Service
-%Adobe Flash Playe... This service ... Manual Local Syste...
i, Adobe Genuine 5.  Adobe Gen...  Started Automatic Local Syste...
-%Adobeu pdateServ... Started Automatic Local Syste...
-%Application Experi... Processesa.. Started Manual Local Syste...
-%Application Host... Provides ad... Started Automatic Local Syste...
-%Application Identity Determines ... Manual Local Service
-%Application Infor..  Facilitates t... Manual Local Syste...
-Q‘;Application Layer .. Providessu.. Manual Local Service
-%Application Mana... Processesin.. Started Manual Local Syste...
4 ASP.NET State Ser... Provides su... Manual MNetwork: 5...
-%AxTraxNG Server AxTraxMG 5., Started Automatic (D... Local Syste...
E.s) Background Intelli... Transfersfil... Started Automatic (D.. Leocal Syste...
E.s) Base Filtering Engi... The BaseFil... Started Automatic Local Service

7 BitLocker Drive En... BDESVC hos... Manual Local Syste...
S&} Block Level Backu... The WBENG... Manual Local Syste...
S.e} Bluetooth Support.. The Bluetoo... Manual Local Service
% BranchCache This service ... Manual Metwork 5.

Q} Certificate Propag... Copies user ... Manual Local Syste...
4 CNG Key solation  The CNG ke... Manual Local Syste.. =
< i | »

Extended /(\Standard/

13. Scroll down and right-click Windows Firewall and click Restart from the pop-up menu.

14. Right-click SQL Server (AXTRAXNG) and click Restart from the pop-up menu.

15. Right-click SQL Server Browser and click Restart from the pop-up menu.

The Firewall is now configured for AxTraxNG.
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Appendix B. Opening a Program in Windows’ Firewall

To Open A Port In Windows’ Firewall:

1. Open the Control Panel.

2. Click the Windows Firewall category.
i’ Windows Firewall
3. Click Advanced settings in the left column of the Windows Firewall window.
Control Panel Home

Allow a program or feature
through Windows Firewall

@' Change notification settings

@' Turn Windows Firewall on or
off

'@' Restore defaults
'@' Advanced settings

Troubleshoot ¥y network

4. Inthe console tree on the left, click Inbound Rules.

|i Windows Firewall with Advance
Inbound-Rules
&Y Outbourd Rules
E‘!, Connection Security Rules

» B Monitoring
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5. Inthe right column, click New Rule.
Inbound Rules s

Mew Rule... o

Filter by Prni;é

Filter by State

44«48

Filter by Group

v T v v

Yiew
|G| Refresh

|5+ Export List...

Help

Skype -
# Disable Rule

gg Cut

5= Copy

x Delete

El Properties

Help

The following screen opens:

What type of rule would you like to create?

@ Program

Rule that controls connections for a program.
) Port

Rule that contrals connections fora TCP or UDP port.
1 Predefined:

BranchCache - Contert Retrieval (Uses HTTF)

Rule that controls connections for a Windows experence.
"1 Custom

Custom rule.
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6. With Program selected by default, click Next.

The following screen opens:

Dioes this rule apply to all programs or a specific program 7

(1 All programs
Rule applies to all connections on the computer that match other nule properties.

@ This program path:

| Browse...

Example: cpathprogram exe
% ProgramFiles % \browser\browser exe

7. With This program path selected by default, click Browse and locate the AxtraxServerService.exe file,
which is located in C:\Program Files (x86)\Rosslare\AxTraxNG Server.

8. Click Next.

The following screen opens:
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What action should be taken when a connection matches the specified conditions?

@ Allow the connection
This includes connections that are protected with |Psec as well as those are not.
i1 Allow the connection if it is secure
This includes only connections that have been authenticated by using IPsec. Connections

will be secured using the settings in |Psec properties and rules in the Connection Security
Rule node.

(' Block the connection

9. With Allow the connection selected by default, click Next.

The following screen opens:

When does this rule apphy?

Domain
Applies when a computer is connected to its comporate domain.

Private
Applies when a computer is connected to a private network location.

Public
Applies when a computer is connected to a public network location.

10. With all three check boxes selected by default, click Next.

The following screen opens:
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Mame:

Description (optianal):

11. Enter a name of the rule, such as “NG Server” and click Finish.

Appendix C. WAN Connection Troubleshooting

This appendix presents three scenarios of a server connection problem.

C.1 Server is Down or Wrong IP and Port Configuration

When starting the AxTraxNG Client, the following error notification appears:

[SoverComnectonfaie | |

Wreng server address, Press OK to close the Client
and to open Configuration Tool.

Click OK to close the AxTraxNG client and start the AxTraxNG Configuration tool.

C.2 Server is Down or Network Failure between AxTraxNG
Client and AxTraxNG Server

The Events log shows a communication error:
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@ lle® &P
Date/Time Location Operator Event
5F | 04/09/2014 09:31:16 Server Information || Communication Established
5| 04/00/2014 09:31:26 Server Event || Communication Established
E! 04,/09/2014 09:31:16 Request From Server .Hecoverlng Lommunication
E! 04,/09,/2014 03:31:16 Event From Server Recovering Communication
E! 04,/09/2014 09:30:46 Request From Server Recovering Communication
E! 04,/09,/2014 03:30:46 Event From Server Recovering Communication
5 04/09/2014 09:30:18 Server Information FCCmmunicaton Eetabnenment raned |
E! 04,/09/2014 09:30:18 Server Event Communication Establishment Failed
E! 04,/09/2014 09:30:16 Request From Server Recovering Communication

Check if the server is down. Check if its address was changed or if the network connection has errors.

C.3 IP + Port Setting are Fine but Client Does Not Start

Check the following possible firewall problems:
Check firewall for server PC

* Check firewall for client PC

Check firewall to Server network

Check firewall to Client network
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Appendix D. SQL Service Settings

1. To reach the SQL Service Settings, click the following path from the Control Panel in Windows XP:

Control Panel > Administrative Tools > Services and Applications > Services > SQL Server
(VERITRAX)

2. Double click "SQL Service (VERITRAX)" the following dialog opens:

T
SQL Server (VERITRAX) Properties (Local Computer) ==

General | Log On | Recovery | Depmdmd&a|

Service name: MSSOLEVERITRAX
Display name: SQL Server (VERITRAX)

data. and rapid transaction processing.

-

Description: Frmvides storage, processing and cortrolled access -

Path to executable:
"C:\Program Files f86)"Microsaft SQL ServerMSSQLTT.SAMSSALBinn®

Startup type: [Momahc 7

Help me corfigure service startup options.

Service status:  Started

Start | [ Stop ] [ Pause ] | Resume

You can specify the start parameters that apply when you start the service
from here.

Start pararneters; | |

Lok J[ Conesl || ‘eny |

3. Onthe General tab, verify that the Startup type is “Automatic” and that the Service status is “Started”.

Startup type: Automatic o

Help me configure service startup options.

Service status: Started
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4. Onthe Log On tab, verify that the Local System Account option is selected. Restart the computer for

the changes to take effect.

General | Log On |Hﬂmvery|[]vependerm&a|

Log on as:

i@ Local System account
Alow service to interact with desktop

i This account: |

| | Browse. .

Paszwiord: |

Confirm pagsword: |

Help me configure user account log on options.

5. If you've made any changes, restart the computer for the changes to take effect.
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Appendix E. Configuring a Network

The AxTraxNG Server connects to access control units by a serial connection, a TCP/IP connection.

E.1 TCP/IP Connection

To connect access control panels to AxTraxNG over a TCP/IP LAN or WAN, the use of a TCP/IP to Serial
converter is required, unless the panel has an onboard TCP-IP connection (AC-225IP).

Each TCP/IP connection can support up to multiple access control panels that are connected to each other
using RS-485 (up to 32 AC-215, AC-215IP, AC-225, or AC-425 panels, or up to 12 extensions with the AC-
825IP panel).

[ = Therecommended RS-485 cable is a shielded twisted pair (22 AWG). J

The hardware used to connect to the TCP/IP network may be the MD-N32, which is a serial to Ethernet
converter, or the onboard converter of the AC-225IP.

To Configure A TCP/IP Connection To A Network:

1. Inthe Tree View, click AC Networks.

2. Onthe toolbar, click the Fl icon.

The Networks window opens.

3. Setthe Network type as TCP/IP.

2 If you want to work with Remote, select Remote (WAN) in the TCP/IP Network window, and
add the WAN IP Address of the PC.

4. Click Configuration.
The TCP/IP Configuration window opens.
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10.
11.

12.

TCP/IP Configuration (2]
MAC Address Status Configuration Version Configuration
0050C2B1-8FA2 | Available Corfigured 2 Gateway Type Serial Speed
00:50:C2:78:A7-AB Available Corfigured 52 [MDL”“?»2 Onboard '] [9900 ']
00:08:DC:54:81:A9 Awailable Corfigured 1.1.2dev IP Address Port
192 . 168 . 1D . 47 1001

Subnet Address (Gateway Address

| 255 . 255 .255. 0 | |192.168.10 . 1
Search Options Enabled DHCP Mode
@ Al Networks
©) Direct MAC Address [00:00:00:00:00:00
(7) Direct IP Address | . ; . |

[ ok || comcel |

The upper left window lists all TCP/IP converters connected to the local network, identified by their
MAC address, and indicates if they have been previously assigned to a network or not.

From the MD-N32 list (the MD-N32's MAC address should be labeled on the TCP/IP converter), select
the appropriate MAC address.

In Gateway Type, select the type of TCP/IP converter (MD-N32, MD-IP32 Onboard, or any other valid
option).

For an AC-825IP panel, the IP module should be configured to the AxTraxNG server. Even if the IP
module was configured before, you need to click Apply to configure with the server and then click OK to
add the AC-825IP network.

Enter the IP address and subnet address for the computer's network.

Select the serial speed of your connection and enter the port number. Itis recommended to select a
higher value port number (4001 or higher). Note that the selected should not end with zeros (prefer
setting Port value of 4243 rather than 4200). This avoids colliding with port addresses reserved for
various equipment installed on the same network.

Enter the default gateway address of the computer’s network.
Click OK to start the verification process.

Turn off the MD-N32 power (or panel power if using the onboard module, such as MD-IP32), and then
turn the power on again. This step is necessary when using certain versions of MD-N32 or MD-1P32
models. Skip this step if not applicable.

If configuration applies to a WAN network, disconnect the configured unit from the local network, and
reconnect to the WAN network and access control panels network working over the WAN.
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Appendix F. Using AxTraxNG with more than one
network adapter

When there is more than one network adapter available, the AxTraxNG server service will automatically be
assigned to the highest priority adapter. To avoid the automatic assignment of network adapter to
AxTraxNG server it is necessary to set the priority (Interface metric) of each adapter. The steps to this
procedure are given at support.rosslaresecurity.com.
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Appendix G. Configuring a Biometric Terminal

11.6.1. Configuring a Biometric Terminal

The AxTraxNG server communicates with a biometric terminal in two ways: TCP/IP (either LAN or WAN)
and Wiegand protocols.

Each terminal has a unique MAC address and appears separately in the system.

The AxTraxNG server supports multiple terminals per access control network.

To Configure A TCP/IP Connection To A Biometric Terminal:

1. Inthe Tree View, expand the Biometrics element and select Terminals.

2k
2. Onthetoolbar, click the "M icon.

3. The Terminal Configuration window opens.

|+~ Terminal Configuration @
General
Description Terminal 1
Enabled o

Bio 8000 -

Madel Mumber AY-BESx0 =

Wiegand 26 Bits -
Info
0
TCR/IP Network
MAC Address a
IP Address a
Terminal Capacrty
Port Qo .
Configuration

Cancel
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4. Click Configuration.

The TCP/IP Configuration window opens and automatically searches for any terminals connected to
the network.

M

~ Canfiguration

Serial Number | MAC Address IP Address Model Number  Status Configuration
846 00 A:BB:AC:0 92.168.10.86  AY-B&5x0 Available o gured [P Address

18510103 00:22:CA:88:F7:8C  [192.168.10.95 |AY-BESD Available Not Configured 192.168.10.86

18270182 00:22:CABAFEA44 |192168.10.87 |AY-BE6x0 Available Not Configured

o

ort

5010

Subnet Address

255.255.255.0

Gateway Address

192.168.10.1

| Export 1 | Search 1

The main window lists all terminals connected to the local network, and indicates if they have been
previously assigned to a terminal or not.

5. Select the appropriate terminal.
The terminal’s parameters are displayed in the Configuration area on the right.
6. For aterminal that has not yet been configured:
a. Click Apply.
b. Wait for the list to refresh and see that the terminal’s status is now “Configured”.
c. Select the terminal from the list again.
7. Click OK.

The window closes and the new terminal appears in the Display Area.
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Appendix H. Configuring User Counters

You can use the User Counter options to limit the number of entrances of a particular user. This is done
using the Counter option that appears on the User Properties window (Figure 3: Departments/Users >
User Properties > General Tab in Section Adding an Individual User).

To Configure User Counters:

1. Select the General tab of the User Properties window either as part of the procedure of adding a new
user as described in Section Adding an Individual User, or select an existing user in the
Departments/Users element.

2. Onthe toolbar, click the IF' icon.

In the Counter section of the User Properties window, select Enable.

4. Select Set New Counter and specify the number of allowed entrances for the user using the Counter
Value box.

Courter

Enable Counter Value
Set New Courter |1 < (1to 1000)

5. Click OK.
6. Select the General tab of the Reader Properties (Section General Tab).

7. Inthe Details section, select Deduct User counter.

Deduct User Counter

8. Click OK.

H.1 Resetting Counter on Panel Re-enable

There is an additional counter option that allows you to reset the user counter to its starting value in the
event that a panel is disconnected and then reconnected again.

= If this option is not used, then upon panel re-enable, the user counter continues with its
previous value prior to having that panel disabled.

To Reset The User Counter On Panel Re-enable:

1. Inthe Tree View, expand the AC Networks element.

2. Select a network.
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3. Onthetoolbar, click the IF' icon.
The Panel Properties window opens.

4. Selectthe Options tab.

5. Select Set new counter.

User Counter on re-enable the panel
Set new counter

6. Click OK.
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Appendix I. Enrolling a User’s Fingerprint

% If using DR-B9000 desktop Fingerprint scanner you have to install a dedicated driver to your
Windows PC.

This option is available for users who need to use a biometric terminal.

To Enroll A User's Fingerprint Using A Biometric Reader:

Be sure the biometric terminal is connected.

—_

Inthe Tree View, expand the Users element.

N

Expand the Departments/Users element and select the relevant department.

w

4. Selectthe user and click the E icon.

5. Onthe Credentials tab in the Users Properties window (Section Credentials Tab), click Add from a
Fingerprint Reader.

The Enroll Fingerprint window opens.

Wiegand Format
ﬁ Wiegand 26 Bits |~ |

@ Desktop Reader () Terminal | | - |

{ Enrollment Device

OK ll Cancel l

Enroll

Select device [

6. Select the enrollment source (Enrollment Device).
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2 f using Desktop Fingerprint scanner you will have 2-step enrollment process in additionto a

live Fingerprint image

7. Select the finger that you want to enroll.

8. Click Enroll. You should see the screen shown below. Follow the instructions on the screen for
successful enrollment.

& Deskiop reader two step enrollment process x

1. Press the Scan button
2. Place finger on the sensor - Scan 1
3. Lift the finger from the sensor

4. Place finger on the sensor - Scan 2

Scan timeout 0 ) :010 )

Status

Enrollment started...

Scan | Cancel |

9. Press the Scan button.
10. Place finger on the sensor — Scan 1.

11. Lift the finger from the sensor. Wait 3 seconds.
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12. Place finger on the sensor — Scan 2.

You should see that the finger was read successfully as shown below.

=

®

1. Press the Scan button
2. Place finger on the sensor - 5can 1
3. Lift the finger from the sensor

-

4. Place finger on the sensor - 5can 2

Scan timeout 0 110

Status

SUCCESS

Cancel QK

13. Click OK.

The window closes and the new fingerprint appears in the Details area.

Credertial Type

Fingerprint | - "

14. Click OKin the Users Properties window to accept the fingerprint.
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Appendix J. Enrolling a License Plate

This option allows you to convert alphanumeric characters read by a third-party camera to a Wiegand
format using a user-defined conversion table that is understood by the AxTraxNG system.

To Enroll A License Plate:

1.
2.

In the Tree View, expand the Users element.

Expand the Departments/Users element and select the relevant department.

Select the user and click the I?l icon.

On the Credentials tab in the Users Properties window (Section Credentials Tab), click Enroll License
Plate.

The Enroll License Plate window opens.

Enroll License Plate n

Conversion Table: | Hikvision_DS-2CD4A26FWD-. |

Wiegand Format: |'|||'I.“|egand 64 Bits b |

License Plate: | |

[ ok | | cancel |

5. Select the conversion table (see Section Conversion Table).

6. Enter the license plate number.

7. Click OK.

AxTraxNG™ V27.7.x.x User Guide

177



ROSSLNR=

Appendix K. Enrolling a Face from a Terminal

Appendix K. Enrolling a Face from a Terminal

This option is available for users connected to a terminal.

To Enroll A Face Using A Terminal:

w N~

Select the user and click the Fl

o &

from Terminal.

Be sure the biometric terminal is connected.

In the Tree View, expand the Users element.

icon.

The Face Enrollment window opens.

£ Face Enrollment

r

=

AY-BE350

1

z | Enrzil

| Cancel

6. Select the enrollment source.
7. Click Enroll.

Expand the Departments/Users element and select the relevant department.

On the Credentials tab in the Users Properties window (Section Credentials Tab), click Enroll Face

The left box shows the status while the right box shows how much time you have left to enroll your face.
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Enrcllment started... 00:01:06

8. Stand in front of the terminal, wait until your face is identified, and follow the onscreen instructions.
Once the face is enrolled, the left box displays a success message.

9. Click OK.
The window closes and the new fingerprint appears in the Details area.

10. Click OK in the Users Properties window to accept the face credential.
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Appendix L. Enrolling Credentials using a Desktop
Reader

This option is available for users connected to a desktop reader.

To Enroll Credentials Using A Desktop Reader:

1.
2.
3.

Be sure the desktop reader is connected.
In the Tree View, expand the Users element.

Expand the Departments/Users element and select the relevant department.

Select the user and click the I?l icon.

On the Credentials tab in the Users Properties window (Section Credentials Tab), click Enroll from
Desktop Reader.

Alternatively, you can expand the Users element in the Tree View, select the Cards element, and click the

Enroll from Desktop Reader icon ( Eﬂ ) on the toolbar.

The Enroll from Desktop Reader window opens.
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Desktop Reader Type
DR-6255 -
Card Type

COM Port

Mone -

DR-U955ET Parameters
Technology Type

Mone 'l | Set Configuration
Technology Type is set to:
oK | | Cancal |

m

6. Select the desktop reader type, card type, and COM port from the respective dropdown lists.

7.

from the dropdown and click Set Configuration.

If the DR-U955BT is selected in Desktop Reader Type, then you must also select the technology type

8. Enrollacard by presenting it to the reader. Each card enrolled appears in the screen.

42 15317
429427

9. Selectthe cards to add (added cards are selected by default).
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10. Click OK.
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Appendix M. SQL Server Installation Troubleshoot

When installing the MS SQL Server Express component in a Windows Server (2003 or 2008) environment,
you might get the following error message: "The sa password must meet SQL Server password policy
requirements."

This is because either:
* The domain-enforced policy is preventing the installer from setting the SA user's password, or

* The local security policy is preventing the installer from setting the password

You can temporarily disable this policy while the installation is running and click Retry to let the installation
complete successfully. After installation is finished, you can restore the policy to the desired setting.

If you are on a Domain Controller, check the Domain Controller security settings first:

','m Default Domain Controller Security Settings

File Action View Help
s @ XER | 2E

[P security Settings Policy /. [ Policy Setting [
B @ Account Policies E&force password history Mot Defined
- &) Password Policy (@] Maximum password age Not Defined
i Account Lockout Policy Minimum password age Not Defined

Kerbefos Policy (28] Minirnum password length Mot Defined
® ganaanﬁcms Passward must meet complexity requirements

E m E:::;:% Groups @Sture passwords using reversible encryption Mot Defined

- (8 System Services

(8 Registry

] File System

@Y wireless Network (IEEE 802.11)
(_ Public Key Palicies

-] Software Restriction Policies
-8, 1P Security Policies on Active Dire

Kl | 3|
[ [ I

= If the setting is set on a domain controller, you may need to run GPU date to force the changes

to propagate.

If the server is not part of a domain, check the local security policy.

To Check The Local Security Policy:

1. Openthe MMC console: Start -> Run -> mmc.exe

2. Click File -> Add/Remove Snap-in:
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Add/Remove Snap-in... I}
Qptions..,

1 CA\Windows\system32\services
2 C\Windows\system32\wf

3 CA\Windows\system32\devmgmt

Exit

Consolel - [Console Root] E
File | Action View Favorites Window Help ‘mm’?‘
@ Mew Ctrl+N
= Open... Ctrl+0 -
Save Ctrl+S ) ) n
Save As... p items to show in this view. St
More Actions
Ctrl+M

Enables you to add snap-ins to or remove them from the snap-in consale.

Add the Group policy obj

ect for the Local Computer:

Pl

error saying The sap ¥ |

E56d - (@ cipocumens

4 x|

Fle Edt Vew Favorkes Tooks Help
U | voumontoet rror saying The sa password st me...

f3 - B & v eage- 3Tk - @ FE 3

Local Group Zolcy Otiects e stored on the lozel
rate

Uso the Jromse bution s seisct en f toe Grog Mooy
Otgecs.

I Mlow thefozus ofthe Group Noicr Snapintc b= e

oy aopies £ you savethe centos.

[ |

@ Intemet

100% -

Disable (temporarily) the security policy:
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B (] Software Settngs
3 (] Windows Settings
[ (] Name Resolution Policy

) Scrpts (Startup/Shutdonn)
© 5, Security Settings

(] Software Settngs
@ ] windows Settings

@ ) Administrative Templates

. Store passwords using reversile enaryption
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Appendix N. AxTraxNG Server Monitor

The AxTraxNG Server Monitor is a program that monitors the AxTrax server.

i
Double-click the icon in the Window system tray to open the program.

[ AxTraxNG Server Monitor | o[22
Server nun as service

DE Connection
Restart Server
Cptions

Logged operators: Administrator

Networlcs:
Disconnected 1

Panels:
Mo Fimmware 1

The main window contains the following four topics:

Parameter | Description
Common Info Shows general system information

Changes the DB connection string

N
DB Connection
= | Administrator password is required.
J
Restarts the AxTraxNG server
N
Restart Server
= | Administrator password is required.
J

SMTP configuration

Options Reports directory

® Use static IP option

Once the main window opens, you can click on any of the main topics to open that topic’s screen.
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N.T Common Info

This screen shows general system information: server status, downloads counter, number of networks,
number of panels, and networks and panels status.

N.2 DB Connection

This feature allows you to change the database connection strings.

|\ AaTraxNG Server Monitar | = -2 =]
Common Info Database
A Trax]
Restart Server =
Optionz T
flocalf\Veritrae

Integrated Security
Usemame

LG

Password

User Rights

[¥] Connect To Server [¥] Backup Database

[¥] View Server State [¥] Restore Database

[¥] Read Wiite To Database [¥] Use Extemal Databases

[¥] Upgrade Database | Check Rights

The DB connection screen contains following fields:

Parameter Description

Database

Server

Integrated Security check box

Database name
DB Server path

Select to send username and password of database

Username Database username

Password Database Password

User Rights These fields monitor the user rights in the current database.
k|

You must enter the administrator password to view this screen.
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N.3 Restart Server

If you try to open the AxTraxNG Client but you get an error that the server is not connected, you may need
to restart the server.

To Restart The Server:

1. Click the Restart Server topic.

The Restart Server screen is displayed.

Common Info
DB Connection

2. Click Restart server.
3. Enter the administrator password and click OK.
The server restarts within a few seconds.

In addition, click Clear Database to return the database to its factory default values.

N.4 Options

This screen allows you to set the SMTP configuration, view the reports directory, and set the static IP
option.
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E AxTraxMG Server Monitor E\E
Common Info
DB Connection SMTF Settings
Restart Server ] o
Host: Email Validation
Port: 0 <
User Name:
Password:
Require S5L: [ Unchecked
Reports Directary
C:\ProgramData“Rosslare Enterprises Lid" A TraxMNG 27 5 8.9 Browse
IP Address
[7] Use Static IP
;E' e

The Options screen contains following fields:

SMTP Settings > Host The address of your SMTP server
SMTP Settings > Port The port of your SMTP server

SMTP Settings > User Name The account name of your SMTP server
SMTP Settings > Password The password of the account

SMTP Settings > Require SSL Check if you want your SMTP server to be secured

SMTP Settings > Email

L Click to validate the SMTP settings
Validation

The default location of reports that are generated and saved automatically as

Report Director
P y scheduled (see Section Scheduling a Report).

Check Use Static IP to enter a real IP address.

Server communicates with clients by remote technology. Default Server’s IP
address is 127.0.0.1. If PC uses some network cards or virtual networks
simultaneously, remote communication may be problematic.

IP Address > Use Static IP

= | If Server Monitor does not have permission to write in the server's
directory, the option will fail. User the Readme.txt file to learn
about Windows permissions.
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Appendix O. Adding Custom Wiegand Formats

The Wiegand protocol it the most common protocol between readers and controllers. This protocol is
actually a collection of bits that represents the number of the user card ID.

There are many types of Wiegand protocols. Protocols differ from one another depending on the following
three factors:

* The number of bits sent per card
The most common format is 26-bit, but there are many more types such as 30-, 32-, 35-, and 36-bit.
* The representation of the user number

In each card, there is a number that defines the user, but the representation of this number inside the
Wiegand protocol can be changed. In addition, there is a Facility code in most protocols, which is not
part of the number but is common to all users in this particular area. There are cards with additional
codes such as Site code, but AxTraxNG recognizes them as a Facility code only. This means that if a
card has both a Site code and a Facility code, AxTraxNG recognizes the first Facility code and the
second Facility code is ignored.

® The authentication mechanism and its type inside the bit stream
In most protocols, there is a certain type of authentication of the data transferred from the reader to the

controller.

Once the user knows the format of the card, meaning how many bits there are per card, the user can use
the other two factors to create new rules, which can then be enrolled into the software to teach the
controller to understand the new format.

O.1 Representation

The following options are available when discussing the number representation:

® Card number is represented in a binary or hexadecimal code
All the bits in the protocol are represented with ‘D’, which stands for data.

® Card number is represented in the protocol as a “reverse bytes”. For example, if the number
(hexadecimal) is 34 65 89 32, then it is represented as: 32 89 65 34.

All the bits in the protocol are represented with ‘R’.

® Card number is represented in the protocol as a “reverse bits”. For example, if the number
(hexadecimal) is 34 65 89 32, which is represented in binary code as:

00110700 01100101 10001001 00110010
then in reversed bits format, it is 4C 91 A6 2C, which is represented as:
01001100 10010001 10100110 00101100 in binary.

All the bits in the protocol are represented with ‘Z'.
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® Card number is represented in the protocol as a BCD code (each nibble represents one decimal
character). For example, if the number (decimal) is 658723, then it is represented in binary as: 01100101
10000111 00100011.

All the bits in the protocol are represented with ‘B’.

0.2 Facility Code

If supported in the card, the software must know where it is placed inside the bit array and how many bits it
takes.

Of the 5 representation options presented in Representation, only the data format can be used with the
Facility code; however, all the bits in the protocol are represented with ‘F’ to differentiate it from regular
data.

0.3 Authentication
Usually the array of bits that represents the card number also contains an authentication mechanism that
checks that the data was transferred correctly.
AxTraxNG supports several types of authentication mechanisms as follows:
* Even Parity — One bit provides authentication to either several bits proceeding or following it (according
to the defined protocol). This bit makes the total number of related bits an even number.

The Even Parity bits in the protocol are represented with ‘E’ and all the bits that they verify are
represented with ‘1’

* 0dd Parity — One bit provides authentication to either several bits proceeding or following it (according
to the defined protocol). This bit makes the total number of related bits an odd number.

The Even Parity bits in the protocol are represented with ‘O’ and all the bits that they verify are
represented with ‘1’

* CheckSum - The number of bits (usually 8) provides the sum of the previous bytes.
Checksum bits in the protocol are represented with ‘S’ and all the bits that they verify are represented
with ‘1"

* CheckXor — The number of bits (usually 8) provides a logical XOR value of the sum of the previous
bytes.
CheckXor bits in the protocol are represented with ‘X" and all the bits that they verify are represented
with ‘1"

0.4 Creating New Rules

Using the above principles, we can create new rules for AxTraxNG.
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To Create A New Rule:

1. Inthe Tree View, click AC Networks.
2. Click @ icon.

The Reader Type window opens.

ResderType @
+Ex

Description &
Wiegand 26 bits

Clock and Data

Wiegand 35 Bits

Wiegand 37 Bits

Wiegand 32 Bits

Wiegand 32 Bits Reversed

Wiegand 34 Bits

Wiegand 40 Bits

Wiegand 40 PCSC Bits

‘Wiegand 64 Bits

Wiegand 37 Bits (10bit FC./16bit 1D)
Clock and Data 6 digits

Wiegand 37 long 1D (16bit FC/19bit 1D}
Wiegand 37 (Rosslare)

Wiegand 37 (AWID)

3. Click the + icon.

The Custom Reader Settings window opens.

| Custom ResderSettngs @

Description
Custom Format 3

MNumber of bits
26 2 Set as Defautt

Rules

4. Enter a description of the new rule.
5. Select the number of bits the new rule will use.

6. [Optional] Select Set as Default.
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7. Inthe Rules section, enter the protocol rules according to the guidelines described in Sections
Representation through Authentication and as shown in the example below.

4 The protocol definition is for the entire system and not per controller.

Example

Enter a new Wiegand 29-bit protocol with the following rules:
® Rule 1: Bit 1 — Odd parity on the bits 3—15

* Rule 2: Bit 2 — Even parity on the bits 16—28

* Rule 3: Bit 29 — 0dd parity on the bits 1-28

* Rule 4: Bits 11-28 — ID data

® Rule 5: Bit 3-10 - Facility code

The new protocol appears in the Custom Reader Settings window.

Custom Reader Settings [E3]

Description
Wiegand 29 NEW

Number of bits
39 |-

: [T Set as Defauit Bit 1 — Odd Parity on Bits 3 to 15
Rules / (the other bits are 0)

00111111111111100000000000000 &

Dié D = D ¥ . Did AL & faYel
DE000000000000001111111111110  @—— Bit 2= Even Parity on Bits 16 to 28
RARRARARARRRRARARRARARARRIC I (the other bits are V)
0000000000DDDDDDDDDDDDDDDDDDN
DOFFFFFFFF I arity on bits 1 to

(the other bits are 0)

NN
N\

Facility - Bits 3to 10 10 _Bits 11 to 26 (the
(the other bits are 0) other bits are 0) o [conea
-
= Please note that the first character in the first row and the last character in the third row, which
represents the odd parity, is a capital “O” and not a zero (0).
\

The new protocol now appears in the list of available protocols.
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]|
Reader =]
General | Options | Access Event
Details
Description Single Operation Mode
[1\Panel AC-825IP\Reader 1 | | Card Only v |
Direction: @ In Dual Authertication Mode
@ Out Time Zone
Activation: Open 1%Panel AC-825IP\Door 1 [ Never |
Mumber of Sessions Session Timeout
Deduct User Courter 10 21 {sec)
Cptions
Primary Reader Format Keypad Type
iw ﬁw vi [hadive v]
Wiegand 26 bits
Clock and Data Door Opening Requirement in Card+Card Mode
Wiegand 35 Bits -
VWisgand 37 Bits [2Usen )
Wiegand 32 Bits Biometrics
Wiegand 32 Bits Reversed
Wiegand 34 Bits Biometric Terminals
Wiegand 40 Bits ’t&st v]
Wiegand 40 PCSC Bits
Wiegand &4 Bits
— Wiegand 37 Bits (10bit FC/16bit 10)
Clock and Data & digits oK Eaneed
Wiegand 37 long 1D (1&bit FC/19bit 10} l [ ]
Wiegand 37 (Fosslare)
L Wiegand 37 (AWID
Wiegand 29 NEW

Wiegand 56

Wiegand 38 Bit (Rosslare Proprietary)

The representation of each existing protocol can be viewed.
To View The Format Of Existing Protocols:

1. Inthe Tree View, click AC Networks.
2. Click the @ icon.

The Reader Type window opens.
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+7= X
Description &

Wiegand 26 bits

Clock and Data

Wiegand 35 Bits

Wiegand 37 Bits

Wiegand 32 Bits

Wiegand 32 Bits Reversed

Wiegand 34 Bits

Wiegand 40 Bits

Wiegand 40 PCSC Bits

Wiegand &4 Bits

Wiegand 37 Bits (10bit FC/16bit 1D}

Clock and Data & digits

Wiegand 37 long 1D {16bit FC./15bit 10)

Wiegand 37 (Rosslare)

Wiegand 37 (AWID)

iar s

3. Double-click the protocol you wish you view (in this case, Wiegand 26-Bit). Alternatively, you can select

the protocol you wish to view and click the icon.
The Reader Settings window opens.
Resder Settings 0 g]

Description
|Wiegand 26 bits |

Mumber of bits

Set as Default

Fules

E1111111111110000000000000
00000000000001111111111110
0000000000000 DDDDDODODDDD
OFFFFFFFFO0000000000000000

- The protocol representation is for viewing only and cannot be edited.

\_
For help in creating a new protocol, please refer to Customer Support.
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Appendix P. Software License and Maintenance Agreements

Appendix P. Software License and Maintenance
Agreements

The full ROSSLARE Software License Agreement (SLA) and Maintenance Agreement are available in the
Quick Links section on the ROSSLARE website at www.rosslaresecurity.com.

Rosslare considers any use of this product as agreement to the REL Software License Agreement (SLA)
and Maintenance Agreement terms even if you do not review them.
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For more information regarding support, visit https://support.rosslaresecurity.com/portal/en/home.

www.rosslaresecurity.com ROSSILNR=

0706-0960714+01
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